
Before the Installation

Windows NT Versions and Platforms Supported
Several versions of Diskeeper are available:
Diskeeper 4.0 for Windows NT Server is supported on version 4.0 of the Windows NT Server operating system. 
It can also be installed on Windows NT Workstations. 
Diskeeper 4.0 for Windows NT Workstation is supported on version 4.0 of Windows NT Workstation. 
An earlier version, Diskeeper 1.0, is available on request for Windows NT 3.5 and 3.51 systems.
Diskeeper 4.0 runs on the following Windows NT computer platforms:

· Intel x86 platform (including Pentium and compatible CPUs from other manufacturers)
· Digital Alpha platform

File Systems Supported
Diskeeper supports the NTFS and 16-bit FAT file systems, but the 12-bit FAT file system is not supported.    (The 
12-bit FAT file system is used on FAT partitions smaller than 16 megabytes in size, such as floppy disks.) Also, 
NTFS partitions formatted with a cluster size larger than 4 kilobytes are not supported.

Disks Supported
Diskeeper supports a wide range of SCSI and IDE disks, including:

· Primary Partitions
· Extended Partitions 
· Logical Drives
· Volume Sets
· RAID Arrays

Resource Requirements
The disk space requirements for Diskeeper vary, depending on the computer platform upon which it is installed.    
The table below lists the disk space requirements by platform.

Platform Space Required
Intel x86 2 megabytes or less
Alpha 4 megabytes or less



Installation Overview

Diskeeper is installed by the SETUP.EXE program supplied on the Diskeeper CD-ROM.    The SETUP.EXE 
program:

· confirms that you have Administrator privileges.
· determines which version of Windows NT you are running.
· checks for sufficient space on the disk for the installation.
· recognizes and will install over previous versions of Diskeeper.
· copies the Diskeeper files to the destination directories, updates the Windows NT Registry, starts the 

Diskeeper service, and creates a new Program Group for Diskeeper.
· offers you the option to register Diskeeper at Executive Software's Web site.



Installation Procedure

Please Note: If you have previously installed Diskeeper Lite on your computer, Executive Software recommends 
that you uninstall it before proceeding with the installation of Diskeeper 4.0.    If, however, you decide to leave 
Diskeeper Lite on your system, be aware that uninstalling Diskeeper Lite after the installation will remove certain 
Windows NT Registry entries used by Diskeeper 4.0, and you will need to re-install Diskeeper 4.0.    Use the 
Add/Remove Programs applet in Control Panel to uninstall Diskeeper Lite.
To install Diskeeper, you must be logged into an Administrator account. 
Click here for more information.



Installation Procedure Steps

1 Insert the Diskeeper CD-ROM into the appropriate drive on your computer.
2 The Windows NT 4.0 AutoPlay feature automatically determines the computer platform you are using and 

begins installing the correct version of Diskeeper.    If you have disabled the AutoPlay feature, perform these 
steps:

a) From the Windows NT Explorer, expand the directory folders on the Diskeeper CD-ROM.    You will see 
directory folders for these platforms:

X86 — for the Intel PC platform (includes Pentium)
Alpha — for the Digital Alpha platform

b) Double click SETUP.EXE in the directory folder representing your computer platform.    This causes the 
Executive Software Setup Window to be displayed.

3 Click Next when the welcome message appears.
4 As an option, you can choose the destination location for the Diskeeper files.    By default, Diskeeper will be 

installed in \ExecSoft\Diskeep on your Windows NT boot partition.    To choose another disk partition or 
directory, click Browse.    If you choose another partition or directory, click OK to accept the new destination 
location.    Any valid local disk drive and directory names are acceptable.    If the directory you specify does 
not exist, a new directory will be created by the Setup utility.

5 After accepting or editing the path name, click Next.
6 After a short period of copying files, the Diskeeper Program Group is created and the installation is complete.



After the Installation

Registering Diskeeper
After the Diskeeper installation is complete, you are given the option to register your Diskeeper purchase. You 
can register Diskeeper at the Executive Software Web site, or FAX the registration card included in the Diskeeper 
package to Executive Software.    Both methods provide a fast, efficient way to register Diskeeper.
The online Web-based registration option requires that you have a default Web browser or navigator installed on 
your computer.
Be sure to register your Diskeeper purchase to receive the free 90 days of telephone support included with 
Diskeeper.

A Note about Installing Service Packs
Since Diskeeper utilizes mechanisms built into Windows NT 4.0 that allow the safe movement of files on a disk 
that is actively being accessed by users, there is no need to upgrade Diskeeper each time you install a new 
Windows NT Service Pack upgrade.
However, Executive Software recommends uninstalling Diskeeper before you install the Windows NT Service 
Pack.    This ensures that Diskeeper Registry entries are not modified by the Service Pack upgrade.    See 
Uninstalling Diskeeper for more information about uninstalling Diskeeper.

A Note about Repairing Your Windows NT System
Performing an emergency repair of a Windows NT system can possibly change or disable certain system 
information or services.    For this reason, it may be necessary to reinstall Diskeeper after repairing your Windows 
NT system.

About the Diskeeper Service
Diskeeper 4.0 is primarily designed as a "Set It and Forget It" disk defragmenter.    In order to accomplish this 
goal, it creates a Windows NT service.    The service allows Diskeeper to run in the background while other 
applications are running.    Diskeeper can defragment your disks whether you are logged on to your computer or 
not.
After installation, the Diskeeper service starts automatically each time your Windows NT system is booted.    The 
Diskeeper service runs all the time, whether or not defragmentation is occurring.    This service consumes 
negligible system resources, and in most cases will never need to be disabled.

Setting Up the Application Event Log
Diskeeper messages are placed in the Windows NT Application Event Log.    By default, this log is 512 
kilobytes in size, and is set to overwrite events older than 7 days old.    Diskeeper may quickly fill the log file 
if these default settings are used.    To prevent this, perform these steps to change the size and overwriting 
characteristics of the Application Event Log:
1 From the Windows NT Start button, choose Programs, then the Administrative Tools Program Group.
2 In the Administrative Tools Program Group, choose the Event Viewer.
3 In the Event Viewer, open the Log menu and choose the Log Settings option.
4 In the Event Log Settings dialog box, perform these steps:

n Set the Change Setting to Application Log.
n Set the Maximum Log Size to 2048 kilobytes.
n Enable the Overwrite Events as Needed option.
n Choose OK to return to the Event Viewer Log.



Installing Diskeeper using SMS

Diskeeper can be installed as a distributed installation using Microsoft’s System Management Server (SMS). 
Click here for step by step instructions on how to install Diskeeper using SMS.

Note:    By default, when using SMS, Diskeeper will install to C:\ExecSoft\Diskeep.    To install on a different 
drive or in a different directory, perform one of these two actions:
§ Share the directory where the Diskeeper installable files reside, then log into the target machine and run 

SETUP.EXE from the target machine as described in the Diskeeper for Windows NT User’s Guide; or, 
§ Edit the SETUP.ISS file and change the line szDir=C:\ExecSoft\Diskeep to point to the drive 

and directory where you want to install Diskeeper.



Installing Diskeeper using SMS Steps

1 Insert the Diskeeper distribution media into the appropriate drive on your computer.    Using the Windows NT 
Explorer, you will see these subdirectory folders:

X86 — for the Intel PC platform (includes Pentium)
Alpha — for the Digital Alpha platform

2 Select the appropriate directory for the platform upon which you want to remotely install Diskeeper. 
3 Copy the selected Diskeeper files into a directory that can be accessed by all the servers which will be 

distributing the Diskeeper package.
4 From the SMS Administrator, open the Packages window.    Press <Ctrl-N> to create a new package.
5 Click Import and import the Product Definition File, DKNT.PDF, from the appropriate Diskeeper source 

directory.
6 Click Workstations.
7 Click the ellipsis (...) button next to the Source Directory window.
8 Select the directory into which you copied the Diskeeper files and click OK.
9 Click Close, then click OK to create the package.
10 Drag the package to the target machine(s) in the Sites window of the SMS Administrator. 
11 In the Job Details window, select Install as the Workstation command.
12 Click OK to close the Job Details window.
13 As an option, enter any comments you want in the Comments dialog box.
14 Click OK to send the package to the target machine(s).



Uninstalling Diskeeper

Follow these steps to remove Diskeeper from your computer:
1 From Control Panel, double click Add/Remove Programs.
2 Click the Install/Uninstall tab.
3 Highlight Diskeeper.
4 Click Add/Remove. This removes the Diskeeper program files and registry entries from your computer.    In 

most cases, the Diskeeper installation directory will not be removed.
5 Manually delete the Diskeeper installation directory if it exists.



Analyzing Fragmentation

Diskeeper can perform a comprehensive analysis of the fragmentation on your partitions.    The analysis is shown 
in either a graphic or a text display.    The graphic display shows different-colored areas representing system files, 
paging files, fragmented files, contiguous files, directories, and free space.    The text display shows useful 
information about the extent of fragmentation on a partition.
Click here to see an example of the graphic fragmentation analysis display.
Click here to see an example of the text fragmentation analysis display. After installing Diskeeper, you are ready 
to start Diskeeper and begin defragmenting your disk partitions. In order to see the actual gains from 
defragmentation, analyze the condition of your partitions before you begin defragmenting them. By reviewing the 
graphic and text displays both before and after running Diskeeper, you will be able to see the actual reduction of 
file fragmentation.



Seeing Results
Especially when using Diskeeper for the first time, you may want to see the results of defragmenting your 
partitions.    Diskeeper provides several methods by which you can do this.
In order to see the effectiveness of Diskeeper, it is important to first analyze the fragmentation on your partitions 
before defragmenting them.    This is easily done by double clicking the Analyze icon  in the disk tree.    
Then, after running the analysis, save the analysis results using the Save button in the Text View display.
After saving the analysis results, defragment your partitions by double clicking on a Defragment icon 

 in the disk tree.    Running Diskeeper in the higher-priority "Manual Defragmentation" mode 
ensures your partitions are defragmented quickly.    Once the defragmentation is complete, re-analyze your 
partitions as you did before defragmenting them.    (Remember to save the results to a different file name than the 
"before" results, to avoid overwriting the earlier analysis results.) 
Also, Diskeeper can display a pop-up summary screen each time it is run indicating the general state of 
fragmentation on your partition. This optional screen can be enabled or disabled from the Options menu. By 
default, the summary screen is enabled.
By comparing the "before and after" analysis results, you can see the effectiveness of Diskeeper.    Now, if you set 
and start scheduled "Set It and Forget It" defragmentation jobs for your partitions, Diskeeper can maintain the 
defragmented state of your partitions automatically in the background, with no further intervention from you!



Manual Defragmentation Mode

Diskeeper is designed to be operated in three ways ¾ the Manual Defragmentation    and Set It and Forget It 
modes, which run while your disk partitions are on-line and available to other applications and users, as well as 
the Boot-Time Defragmentation mode.    The Boot-Time Defragmentation mode runs only when you re-boot your 
computer.
The Manual Defragmentation mode allows you to directly control Diskeeper operation.    You have direct control 
over which partitions are defragmented, when defragmentation is started and stopped, and the priority at which 
Manual Defragmentation jobs run.
There are several ways by which to manually start Diskeeper, but the most direct method is to simply double 
click the Defragment icon corresponding to the partition you want to defragment.    Alternatively, click on a 
Defragment icon, then press the Enter key.    You can run more than one manual defragmentation job at the same 
time.
To stop a manual Diskeeper job, first highlight the Defragment icon for the partition you want to stop 
defragmenting, then either click Stop or select the Stop option from the Defragment menu.
If you exit from Diskeeper (or even log off your computer) while a manual defragmentation job is running, the 
job will continue running until it is complete.
By default, manual defragmentation jobs are run at "Normal" priority, the mid-level Windows NT priority.    
Because of this, the performance of tasks running on your computer other than the defragmentation job can be 
impacted.    As an option, you can change the priority at which Diskeeper runs for manual defragmentation jobs.    
To do this, select the Priority option from the Options menu.    Lowering the priority of Diskeeper jobs can help 
speed the performance of other tasks on your system running at the same time, but can cause Diskeeper to take 
longer to defragment your partitions.
Click here for more information about setting the Diskeeper priority.



Set It and Forget It Mode

Diskeeper is designed to be operated in three ways --- the Set It and Forget It and Manual Defragmentation 
modes, which run while your disk partitions are on-line and available to other applications and users, as well as 
the Boot-Time Defragmentation mode.    The Boot-Time Defragmentation mode runs only when you re-boot your 
computer.
The Set It and Forget It mode allows Diskeeper to run automatically in the background while users and other 
processes are active on the system. 
To run Diskeeper in the Set It and Forget It mode, first create a schedule specifying the times Diskeeper either 
will or will not be allowed to run on a specific partition, then start the scheduled defragmentation job.    After a 
defragmentation schedule is created for a partition, Diskeeper will follow that schedule until you explicitly stop 
it.    The defragmentation job will run as scheduled, whether you are logged onto the computer or not.    Also, 
multiple Set It and Forget It defragmentation jobs can be run at the same time on separate partitions.
To stop a Set It and Forget It Diskeeper job run, first highlight the icon for the partition you want to stop 
defragmenting, then either click Stop or select the Stop option from the Defragment menu.    Or, you can open the 
Drive Scheduler dialog box from the Set It and Forget It menu, highlight the partition for which you want to stop 
the schedule, then click Stop.
If you exit from Diskeeper (or even log off your computer) while a Set It and Forget It job is running, the job will 
continue running until the current scheduled run is complete.    It will then be re-scheduled to run at the next 
specified run time.
By default, Set It and Forget It defragmentation jobs are run at the lowest Windows NT priority.    Because of this, 
Set It and Forget It jobs should have a minimal impact on other tasks that are running at the same time.    As an 
option, you can change the priority at which Diskeeper runs for Set It and Forget It jobs.    To do this, select the 
Priority option from the Options menu.    Raising the priority of Diskeeper jobs can slow the performance of other 
tasks on your system running at the same time, but can enable Diskeeper to defragment your partitions more 
quickly.
Click here for more information about setting the Diskeeper priority.



Boot-Time Defragmentation Mode

Diskeeper is designed to be operated in three ways --- the "Boot-Time Defragmentation" mode, which runs only 
when you re-boot your computer; as well as the Set It and Forget It and Manual Defragmentation modes, which 
run while your disk partitions are on-line and available to other applications and users. 
Running during boot-time, the Boot-Time Defragmentation feature:

§ Defragments and consolidates directories into a single location
§ Defragments paging files

This is done at boot-time, since directories and paging files are objects that cannot be defragmented while the 
partition is being accessed by other applications or users.
By its nature, Windows NT allows directories to be written into random locations.    This, in effect, breaks up the 
available pieces of free space on the partition.    By grouping all the directories into a single location on a 
partition, larger areas of contiguous free space become available.    As a result, new files are more likely to be 
written to the partition in a contiguous manner.    This also helps make Diskeeper more effective when it is run in 
either the Set It and Forget It or Manual Defragmentation modes. The same holds true for fragmented paging 
files.    By defragmenting paging files, larger areas of contiguous free space become available for new or 
modified files.
Note, however, that there are two directories that Windows NT expects to find in a particular physical location on 
the partition.    For this reason, the Diskeeper Boot-Time Defragmentation operation excludes these two 
directories and does not move them.    The directories are \Recycler and \Recycled.    Because these two 
directories cannot be moved, the Boot-Time Defragmentation will likely still leave one or two directories that are 
not consolidated with the rest of your directories.
The Boot-Time Defragmentation feature relies on finding enough contiguous free space into which all the 
directories for the paging file will fit.    For this reason, you should run Diskeeper in one of its online modes 
before running the Boot-Time Defragmentation feature.
In most cases, you should run the Diskeeper Boot-Time Defragmentation shortly after the first time you use 
Diskeeper on a partition (Diskeeper should run at least once to create a contiguous free space to move the 
directories into), or after any operation (such as installing a new application) that creates multiple directories.    
By moving all the directories together, you create more contiguous free space for file defragmentation.    After 
running the Boot-Time Defragmentation, use either the Set It and Forget It or Manual Defragmentation modes to 
keep the partition defragmented.
Click here for information about setting a partition for Boot-Time Defragmentation.



Overview of Diskeeper 4.0

§ Diskeeper 4.0’s major enhancement over its predecessor, Diskeeper 3.0, is that it permits paging file 
defragmentation. This greatly increases the effectiveness of disk defragmentation.

§ Two versions of Diskeeper 4.0 are available ¾ one for Windows NT Server and one for Windows NT 
Workstation.    The Server version defragments local and network disk partitions, and the Workstation version 
defragments local partitions only.

§ Diskeeper for Windows NT Server can be installed and run on Windows NT Workstations, allowing you to 
control defragmentation of the partitions on all the computers on your network from either a single Server or 
Workstation.

§ Diskeeper 4.0 is supported on Windows NT 4.0.    It cannot be run on earlier versions of Windows NT.    
Diskeeper 1.0 is available for Windows NT 3.5 and 3.51.

§ Diskeeper supports the NTFS and 16-bit FAT file systems, but the 12-bit FAT file system is not supported.    
(The 12-bit FAT file system is used on FAT partitions smaller than 16 megabytes in size, such as floppy disks.)

§ In its on-line, Set It and Forget It and Manual Defragmentation modes, Diskeeper cannot defragment files on 
NTFS partitions with a cluster size greater than 4K (4096 bytes) in size.    This is due to a limitation in 
Windows NT.    You must have Administrator privileges enabled before running Diskeeper.

§ With Diskeeper, you can analyze the fragmentation on a partition (with a graphic or text display), as well as 
defragment the partition.

§ More than one analysis or defragmentation operation can be performed at a time.    You can analyze or 
defragment partitions independently of each other.

§ When running Diskeeper in the on-line mode, you can run other tasks while defragmentation is occurring.
§ When Diskeeper runs at higher priority levels, performance of other active processes will likely be impacted.
§ When Diskeeper runs at lower priority levels, defragmentation may take longer, since Diskeeper "backs off" 

for other higher-priority processes, including screen savers.
§ Diskeeper runs through the files on the partition in several "stages" during each defragmentation run.    The 

number of stages varies, depending on the number of files and the degree of fragmentation.
§ In the on-line mode, Diskeeper runs as a Windows NT Service and it optionally logs useful defragmentation 

information into the Windows NT Application Event Log.
§ Diskeeper can be uninstalled in the standard manner using the Add/Remove Programs applet in the Windows 

NT Control Panel.    Click here for information about uninstalling Diskeeper.



Theory of Operation

As used in reference to Windows NT, disk fragmentation means two things:
n a condition in which pieces of individual files on a partition are not contiguous, but rather are broken up and 

scattered around the partition; and
n a condition in which the free space on a partition consists of little pieces of space here and there rather than a 

few large free spaces.
The effects of excessive fragmentation are twofold as well:
n file access takes longer because a file must be collected in pieces here and there, requiring several disk 

accesses instead of just one; and
n file creations take longer because space for the file must be allocated in little pieces here and there instead of 

just one contiguous allocation.
Before the introduction of Diskeeper, there was no method for completely correcting the problems of file and free 
space fragmentation on Windows NT computers.
In designing Diskeeper for Windows NT, the following goals were established:
n The product must be completely safe to use.
n It must improve Windows NT system performance.    It is not designed to make the disk look "pretty" --- it’s 

designed to improve disk performance and, as a result, overall system performance.
n It should process live disks without interfering with user access to files.
n It should run without operator intervention.
n It must defragment all possible files and consolidate free space into the smallest possible number of large 

spaces.



Executive Software

Executive Software, founded by its Chairman and CEO Craig Jensen, was incorporated in 1981.    In 1986, 
Diskeeper for VAX/VMS was introduced, establishing Executive Software as the leader in defragmentation 
products for the corporate marketplace.
A fundamental aspect of the company’s corporate purpose has been to help Data Center Managers solve 
performance problems.    Superior technical capability coupled with meticulous market research fueled rapid 
growth for Executive Software, and resulted in a high degree of customer satisfaction.
Executive Software has grown from five people in 1986 to over a hundred today, with headquarters in California 
and branch offices throughout the world.    The expansion of the company and the popularity of its products 
demonstrate a successful implementation of the company’s purpose and the degree of technical and 
administrative capability that backs it up.

Click here to visit Executive Software’s Web site:

{button Visit Executive Software,EF(`Connect.exe',"http://www.execsoft.com",1)}
Note:    It is necessary for you to have a default Web browser or navigator defined on your computer before 
clicking on the button.



Using the Diskeeper Interface

The Diskeeper interface contains pull-down menus and a toolbar.    Many of the functions offered are the same on 
the menus and toolbar.
Click on the different areas of the Diskeeper display shown below for information about that section of the 
Diskeeper display.



Menu Options

Diskeeper has these menu options:

 File Menu
 Analyze Menu 
 Defragment Menu 
 View Menu 
 Options Menu 
 Set It and Forget It Menu 
 Advanced Tools Menu 
 Help Menu 



Toolbar Options

The Diskeeper toolbar offers these options:

    Go Button

    Pause Button

    Stop Button

 View Text Button

 File Exclusion List Button

    Partition Scheduler Button

    Network Scheduler Button

    Help Contents Button



Go Button

Click Go  in the Diskeeper toolbar to begin either a fragmentation analysis or the "Manual 
Defragmentation" of the selected partition.



Pause Button

Click Pause  in the Diskeeper toolbar to temporarily pause a fragmentation analysis or the "Manual 
Defragmentation" of the selected partition.



Stop Button

Click Stop  in the Diskeeper toolbar to stop a fragmentation analysis or the "Manual Defragmentation" of 
the selected partition.



View Text Button

Click View Text  to display a text view of either a fragmentation analysis or the defragmentation of a 
partition.    The text view of a Diskeeper defragmentation job can only be shown after the job has completed.

Click here to see an example of the fragmentation analysis text display.



File Exclusion List Button

Click File Exclusion List  to create a list of files or directories you want to be excluded from being 
defragmented.

Click here to see an example of the file exclusion list dialog box.



Setting An Exclusion List

Diskeeper exclusion lists allow you to specify files and directories that will not be allowed to be processed by 
Diskeeper.    For example, you might not want to defragment temporary files that will soon be deleted.    When 
you choose the Exclusion List button or menu option, the window shown below appears.    Click on the various 
options shown in the window below for more information about the options. Note: Wildcard file specifications 
such as * or ? are not allowed.



Files

Use this section of the Exclusion List window to choose specific files (by name) to be excluded from 
defragmentation.    Choose the name of the file to be excluded, then click Add Files to add the file to the 
exclusion list.



Path

Use this section of the Exclusion List window to choose specific partitions or directories to be excluded from 
defragmentation.
Select a directory by highlighting it, then click Add Path to add the directory to the exclusion list.
When a directory folder is added to the exclusion list, any subdirectories below the directory in the tree are also 
excluded.



Drives

Use this section of the Exclusion List window to choose the disk partition from which you want to exclude files 
or directories.    To exclude an entire partition, highlight the partition name in this section and click Add Path.



Add Files Button

Click Add Files to add the selected file(s) to the Diskeeper exclusion list.



Add Path Button

Click Add Path to add the selected directory path to the Diskeeper exclusion list.



Exclusion List Box

This dialog box shows the files, directories, and partitions that will be excluded from defragmentation.



Remove Button

Click Remove to remove specific files, directories, or partitions from the Diskeeper exclusion list.    To remove 
an item from the list, highlight the item by clicking on it in the Exclusion List Box and click Remove.



File List

This section of the Exclude Files dialog box lists the files matching the specification shown in the File Name edit 
box.



Directory Folder List

This section of the Exclude Files dialog box lists the directory folders in the selected partition.



Save Button

Click Save to save the exclusion list and return to Diskeeper.



Cancel Button

Click Cancel to cancel any changes you have made to the Diskeeper exclusion list and return to the opening 
Diskeeper screen.



Help Button

Click Help for context-sensitive help about the Diskeeper file exclusion list option.



Partition Scheduler Button

Click Partition Scheduler  in the Diskeeper toolbar to create a defragmentation schedule for one or more 
specific disk partitions.    With the Windows NT Server version of Diskeeper, you can create defragmentation 
schedules for any computer on your network that is also running Diskeeper.

Click here to see an example of the Set It and Forget It Partition Scheduling dialog box.
Use a defragmentation schedule to specify times when "Set It and Forget It" defragmentation jobs will be forced to 
run, or times they will not be allowed to run. 

Schedules only affect "Set It and Forget It" defragmentation jobs.    Any active defragmentation job previously 
started on a partition will complete.    After any previously started jobs complete, the new schedule takes 
effect.
When you use the Partition Scheduler, always select one or more partitions in the Partition List box before 
clicking on any of the other Partition Scheduler controls.    To select more than one partition to schedule, hold 
the <Ctrl> key while clicking on the partitions listed in the Schedule box that you want to schedule.    Or, you 
can hold the <Shift> key to select a continuous list of partitions in the Schedule box.
Note that to set or alter a run schedule on remote computers on your network (with Diskeeper for Windows NT 
Server), you must have sufficient permissions to edit a file in the Diskeeper directory on the remote computer. 
See Troubleshooting Network Connections for more information.



Network Scheduler Button

Please note: This option is only available in the Windows NT Server version of Diskeeper.

Click Network Scheduler  in the Diskeeper toolbar to create a defragmentation schedule for all the disk 
partitions on one or more specific computers, workgroups, or domains on your network. 

Click here to see an example of the Set It and Forget It Network Scheduling dialog box.
Use a defragmentation schedule to specify times when "Set It and Forget It" defragmentation jobs will be forced to 
run, or times they will not be allowed to run. 

Schedules only affect "Set It and Forget It" defragmentation jobs.    Any active defragmentation job previously 
started on a partition will complete.    After any previously started jobs complete, the new schedule takes 
effect.
When you use the Network Scheduler, always select one or more computers, workgroups, or domains in the 
Machine List box before clicking any of the other Network Scheduling controls.    To select more than one item 
to schedule, hold the <Ctrl> key while clicking on the computers, workgroups, or domains listed in the 
Machine List box that you want to schedule.    Or, you can hold the <Shift> key to select a continuous list of 
items in the Machine List box.
Note that to set or alter a run schedule on remote computers on your network (with Diskeeper for Windows NT 
Server), you must have sufficient permissions to edit a file in the Diskeeper directory on the remote computer. 
See Troubleshooting Network Connections for more information.
Also note that you cannot use the Network Scheduler to schedule defragmentation on the computer you are 
currently connected to.    Use the Partition Scheduler to create a schedule for any computer you are currently 
connected to.



Scheduling Diskeeper

A number of Diskeeper scheduling options exist.    You can specify separate defragmentation schedules for 
individual partitions, or you can create a single schedule for more than one partition.
A defragmentation schedule specifies the times or days of the week that Diskeeper will (or will not) be allowed to 
run.
With the Windows NT Server version of Diskeeper, you can create defragmentation schedules for other 
computers on your network (if they are also licensed to run Diskeeper).    Diskeeper for Windows NT Server even 
allows you to create defragmentation schedules for all the partitions on individual computers on your network.
Click here for information about creating defragmentation schedules for individual partitions.
Click here for information about creating defragmentation schedules for all the partitions on your network.



Partition Scheduler

When you click Partition Scheduler or select the Partition Scheduler menu option, the window shown below is 
displayed.
Click on the various options shown in the window below for more information about the options.



Network Scheduler

Please note: This option is only available in the Windows NT Server version of Diskeeper.
When you click Network Scheduler or select the Network Scheduler menu option, the window shown below is 
displayed.    Click on the various options shown in the window below for more information about the options.

The scheduling of remote computers is accomplished by the Network Scheduler, a feature exclusive to Diskeeper. 
This feature allows you to easily set the same "Set It and Forget It" schedule for all the partitions on one or more 
computers at a time.
To fully use this feature, it is important to understand the method by which Diskeeper creates and controls 
defragmentation schedules on remote computers.    When you create a schedule for a computer, Diskeeper stores 
all the necessary scheduling information in a control file (Diskeep.ctl) on the computer for which the schedule 
was created.    Then, the Diskeeper Service periodically checks the control file to determine whether to start the 
Diskeeper defragmentation engine on that computer.
The Network Scheduler is a unique feature of Diskeeper (Server version), without which it would be necessary 
for you to connect individually to each computer you wanted to schedule, then specify the schedule(s) for each of 
the computer's partitions.    This action would update the Diskeeper control file on each computer.    Not an easy 
task if you have a few hundred (or thousand) computers on your network!
In the Server version of Diskeeper, the Network Scheduling Engine performs the work of updating the Diskeeper 
control files on one or more remote computers, without the need for you to individually connect to each 
computer.    This is the sequence of events:

§ First, the scheduling information for any selected computers is stored on the local computer from where you 
are creating schedules.    This information is stored in the \NetScheduler folder under the folder where you 
installed Diskeeper.    Individual files are written to this folder for each computer on which you schedule 
Diskeeper to run.

§ Next, the Network Scheduling Engine is started, running as a separate process.    The Network Scheduling 
Engine checks all of the machine-specific scheduling information files on the local computer each time the 
engine is started.    If any of the files are new or changed since the last time the engine was run, it connects to 
each respective computer and sends the new or changed information to the Diskeeper control file on the 
remote computer(s).

§ Then, when the Diskeeper Service on each of the individual remote computers checks its control file, it begins 



running as specified by the schedule.    The Diskeeper Service checks its control file once a minute.
Note that to set or alter a run schedule on remote computers on your network (with Diskeeper for Windows NT 
Server), you must first connect to the remote computer via the tree view in the Diskeeper display. Also, you 
must have sufficient permissions to edit a file in the Diskeeper directory on the remote computer.    See 
Troubleshooting Network Connections for more information.
Also note that you cannot use the Network Scheduler to schedule defragmentation on the computer you are 
currently connected to.    Use the Partition Scheduler to create a schedule for any computer you are currently 
connected to.



Partition List

Use this section of the Partition Scheduler display to specify one or more disk partitions for which you want to 
establish a defragmentation schedule.
Always select the disk partition(s) for which you are specifying a schedule before clicking on any of the other 
Partition Scheduler controls.
Any defragmentation job previously started on a partition will complete the current run through the partition 
before the new run schedule takes effect.
The Partition List section of the Partition Scheduler dialog box lists the partitions detected on the computer 
you are currently connected to, and shows the partitions that are actively being defragmented or that are 
scheduled for defragmentation by Diskeeper.    This display also shows the scheduled time for the next 
defragmentation run for each scheduled partition.



Run

Use this section of the Partition Scheduler display to specify how often Diskeeper should run on the selected 
partitions.    You can specify any of these run frequencies:
                One Time
                Continuously
                Every 2 hours
                Every 4 hours
                Every 8 hours
                Every 12 hours
                Every 24 hours
                Every 48 hours
                Every 72 hours



When

Use this section of the Partition Scheduler display to specify days the Diskeeper job will (or will not) be 
allowed to run on the selected partitions.    You can specify any of these time periods to control when 
Diskeeper is allowed to run:
Everyday Except Everyday
Weekends Except Weekends
Weekdays Except Weekdays
Mondays Except Mondays
Tuesdays Except Tuesdays
Wednesdays Except Wednesdays
Thursdays Except Thursdays
Fridays Except Fridays
Saturdays Except Saturdays
Sundays Except Sundays



Between

Use this section of the Partition Scheduler display to specify the beginning of a time period the Diskeeper job 
will (or will not) be allowed to run on the selected partitions.    You can specify any of these time periods to 
specify the beginning of a Diskeeper schedule period:
                All Day
                12:00 midnight through 11:00 P.M. in one hour increments



And

Use this section of the Partition Scheduler display to specify the end of a time period the Diskeeper job will or 
will not be allowed to run on the selected partitions.    You can specify any of these time periods to specify the 
end of a time period Diskeeper will (or will not) be allowed to run:
                  12:00 midnight through 11:00 P.M. in one hour increments



Start Button

Click Start to accept the specified run schedule for the selected partitions.    You must click Start for each 
schedule you specify.
Any defragmentation job previously started on a partition will complete the current run through the partition 
before the new schedule takes effect.



Stop Button

Click Stop to stop a scheduled Diskeeper defragmentation job and clear the schedule for the selected partitions.



Close Button

Click Close to leave the Partition Scheduler window.
Click Start before clicking Close to accept a schedule you have specified.
Do not click Start if you don’t want to accept the schedule you have set.



Help Button

Click Help to view help information about using the Diskeeper in the "Set It and Forget It" mode.



Help Contents Button

Click Help Contents  to activate the Diskeeper Help system.    You knew that already, right?



Machine List

The Machine List section of the Network Scheduler dialog box lists the computers, workgroups, and domains 
detected on your network, and shows the scheduling status of each.
Use this section of the Network Scheduler display to specify one or more computers, workgroups, or domains 
for which you want to establish the same defragmentation schedule on all partitions.
Double click any domain or workgroup shown in the Machine List to display the computers within that group. 
(Keep in mind, however, that you can also schedule entire domains or workgroups.)    To select more than one 
item to schedule, hold the <Ctrl> key while clicking on the computers, workgroups, or domains listed in the 
Machine List box that you want to schedule.    Or, you can hold the <Shift> key to select a continuous list of 
items in the Machine List box.
Always select the computer(s) for which you are specifying a schedule before clicking on any of the other Set 
It and Forget It dialog boxes.



Run

Use this section of the Network Scheduler display to specify how often Diskeeper should run on all the 
partitions on the selected computers.    You can specify any of these run frequencies:
                One Time
                Continuously
                Every 2 hours
                Every 4 hours
                Every 8 hours
                Every 12 hours
                Every 24 hours
                Every 48 hours
                Every 72 hours



When

Use this section of the Network Scheduler display to specify days the Diskeeper job will (or will not) be 
allowed to run on the selected computers.    You can specify any of these time periods to control when 
Diskeeper is allowed to run:
Everyday Except Everyday
Weekends Except Weekends
Weekdays Except Weekdays
Mondays Except Mondays
Tuesdays Except Tuesdays
Wednesdays Except Wednesdays
Thursdays Except Thursdays
Fridays Except Fridays
Saturdays Except Saturdays
Sundays Except Sundays



Between

Use this section of the Network Scheduler display to specify the beginning of a time period the Diskeeper job 
will (or will not) be allowed to run on the selected computers.    You can specify any of these time periods to 
specify the beginning of a Diskeeper schedule period:
                All Day
                12:00 midnight through 11:00 P.M. in one hour increments



And

Use this section of the Set It and Forget It display to specify the end of a time period the Diskeeper job will or 
will not be allowed to run on the selected volume.    You can specify any of these time periods to specify the 
end of a time period Diskeeper will (or will not) be allowed to run:
                  12:00 midnight through 11:00 P.M. in one hour increments



Set Remote Schedule

Use this option to set the specified schedule on the selected computer(s).    When you click Set Remote 
Computer, the scheduling information is written to the local computer in the \NetScheduler folder under the 
folder where you installed Diskeeper.    Individual files are written to this folder for each computer on which you 
schedule Diskeeper to run.
After clicking this option, you must click OK or Send Schedules to start the Diskeeper Network Scheduling 
Engine, and to begin sending the schedule information to the remote computers.    OK starts the engine and closes 
the dialog box ¾ Send Schedules does the same, but does not close the dialog box.    Once the engine starts, it 
checks the individual scheduling information files on the local computer, determines which ones are new or have 
changed, then sequentially connects to each respective computer and updates the Diskeeper control file on each 
computer.
As the Network Scheduling Engine runs, a status window is displayed, showing computer currently being 
scheduled and the progress of the connection.    You can click Cancel in the status window at any time to stop the 
Scheduling Engine, but keep in mind that the schedules on any computers that were "Ready" when the Network 
Scheduling Engine was started will not be updated until the next time the engine is started.



Clear Remote Schedule

Use this option to clear a schedule you have previously set on the selected domains, workgroups, or computers, 
after you have clicked either OK or Send Schedules.
Much like setting a schedule, clearing a schedule    also involves writing scheduling information to disk on your 
local computer.    This information is essentially a schedule set to not run.    Once this information has been stored 
on the local computer (as indicated by the "Ready" status), send it to the remote computers by clicking either OK 
or Send Schedules.



OK

Click OK after clicking Set Remote Schedule to start the Diskeeper Network Scheduling Engine, and to begin 
sending the schedule information to the remote computers.    This option starts the Network Scheduling Engine 
and closes the Network Scheduling dialog box.



Cancel

Click Cancel to close the Network Scheduling dialog box without making any changes to the schedules on your 
remote computers.



Send Schedules

Click Send Schedules after clicking Set Remote Schedule to start the Diskeeper Network Scheduling Engine, 
and to begin sending the schedule information to the remote computers.    This option starts the Network 
Scheduling Engine, but does not close the Network Scheduling dialog box.
Any defragmentation job previously started on any partition of any selected computers will complete the 
current run through the partition before the new run schedule takes effect.



Clear Selection

Use this option to clear a schedule on the selected domains, workgroups, or computers, before you have clicked 
either OK or Send Schedules.



Refresh Status

Use this option to display the latest status of the network schedules and connections on your network.
If you use Send Schedules to start the Network Scheduling Engine, click Refresh Status after the Diskeeper 
Scheduling Engine stops, to update the status information in the Machine List box.



Help

Click Help to view context-sensitive help information about using the Diskeeper Network Scheduler.



Disk Drive Icon

Double click any of the disk drive icons to alternately hide and display the Analyze and Defragment icons.



Analyze Icon

Click an Analyze icon to highlight it, then click Go to start a fragmentation analysis of the selected partition. 
Alternately, you can simply double click the Analyze icon to start the fragmentation analysis without needing to 
click Go.



Defragment Icon

Click a Defragment icon to highlight it, then click Go to start the "Manual Defragmentation" of the selected 
partition. Alternately, you can simply double click the Defragment icon to start defragmenting the partition 
without needing to click Go.



Workgroup Icon

Please Note:    This icon only appears with the Windows NT Server version of Diskeeper.
Double click a Workgroup Icon to expand and display a list of all the computers in the Workgroup or Domain.



Rest of Workgroup Icon

Please Note:    This icon only appears with the Windows NT Server version of Diskeeper.
Double click a Rest of Workgroup Icon to expand and display a list of all the other computers in the workgroup 
containing the local computer.



Text Display Button

Click Text Display to switch from a graphic display of your partition to a text report showing the fragmentation 
analysis or defragmentation information.
Click here to see an example of the Diskeeper text display.



Text Display

Much useful information is displayed in the Diskeeper text display.    Click any of the areas of the Diskeeper text 
display shown here for a description about that part of the display.

Note that most of the information shown in the Diskeeper text display can also be recorded in the Windows NT 
Event Log.    Click here for more information about logging Diskeeper information to the Windows NT Event Log.



Text Display Information

This section of the Analysis Information display lists much useful information about the files, directories, and 
free space on your partition.
The following information is shown:
% Partition Fragmented 
Average Fragments/File 
Fragmented Files 
Excess Fragments 
Free Space 
% Free Space 
Used Space 
Total Files 
Partition Size 
Paging File Size 
Use the scroll bar in this display to view this additional information:
Paging File Fragments 
Average File Size 
Total Directories 
Fragmented Directories 
Excess Directory Fragments 
Cluster Size 
MFT Size 
Number of MFT Records 
% MFT in Use 
MFT Fragments 



OK

Click OK to close the Text Display window and return to the main Diskeeper display.



Save

Click Save to save the text results of a fragmentation analysis.    Use this option after running the fragmentation 
analysis.
By default, the analysis file is saved as a file named DriveX.any (where X represents the drive letter) in the 
directory where Diskeeper is installed.    When you click Save, you are given the opportunity to change the file 
name and directory location.
This option is useful for comparing the condition of a partition before and after defragmenting the partition with 
Diskeeper.    Be sure to save the analysis before running Diskeeper, so you can see the benefits of running 
Diskeeper.    See the Open Analysis help topic for more information about opening a previously saved 
fragmentation analysis data file.
Note that if you are saving "before and after defragmentation" analysis files, you should use unique names for the 
files.    This prevents the "before" analysis file from being overwritten by the "after" analysis file. 



Print

Click Print to print the text fragmentation analysis information.    This option sends the fragmentation analysis 
information to whatever printer is designated as your default printer.
This option is useful for comparing the condition of a partition before and after defragmenting the partition with 
Diskeeper.    See the Save help topic for information about saving the fragmentation analysis results.



Help

Click Help to view context-sensitive help about the Diskeeper text display.



Graphic Fragmentation Display

This section of the Diskeeper display shows a graphic representation of the fragmentation of your partition.    The 
colors of the display indicate the type and condition of the data on your partition.
n Green areas show system files, particularly the Master File Table (MFT) but also several other file system 

files. System files like these cannot be safely moved by Diskeeper (or any other defragmenter).    Keep in 
mind, however, these are not the files that make up the Windows NT operating system (which Diskeeper can 
successfully defragment) ¾ they make up the NTFS file system.    The green areas of the display appear only 
on NTFS partitions.

n Green-striped areas show space on the partition reserved for expansion of the MFT.    This space is reserved 
when a partition is formatted, and cannot be used by applications, including Diskeeper.    Windows NT will, 
however, write files to this area when the partition becomes extremely full and no other free space is 
available.    Windows NT provides the capability for Diskeeper to move files out of this reserved area, but 
does not allow Diskeeper to move files into it.    These areas appear only on NTFS partitions.

n Yellow areas show the paging file (if it exists on the partition).
n Light blue areas show the directories on the partition.
n Red areas show fragmented files.
n Dark blue areas show contiguous (non-fragmented) files.
n Gray areas show free space on the partition.



Status Bar

The status bar indicates the percentage done of either the fragmentation analysis or various stages of 
defragmentation.



File Menu

The File Menu contains these options:

    Open Analysis

    Exclusion List

    Exit



Open Analysis

Use the Open Analysis option in the File menu to open and view a previously saved text-format fragmentation 
analysis data file.    When this option is chosen, you are given the opportunity to select the partition, directory, and 
filename of the fragmentation analysis file.
This option is useful for comparing the condition of a partition before and after defragmenting the partition with 
Diskeeper.    See the Save Analysis help topic for information about saving the fragmentation analysis results.



Save Analysis

To save the text results of a fragmentation analysis, first click View Text  and then click Save in the text 
view display.

By default, the analysis file is saved as a file named DriveX.any (where X represents the drive letter) in the 
directory where Diskeeper is installed.    When this option is chosen, you are given the opportunity to change the file 
name and directory location.
This option is useful for comparing the condition of a partition before and after defragmenting the partition with 
Diskeeper.    Be sure to save the analysis before running Diskeeper, so you can see the benefits of running Diskeeper. 
See the Open Analysis help topic for more information about opening a previously saved fragmentation analysis 
data file.

Note that if you are saving "before and after defragmentation" analysis files, you should use unique names for the 
files.    This prevents the "before" analysis file from being overwritten by the "after" file. 



Print Analysis

Use the Print Analysis option in the File menu to print the text portion of a previously saved fragmentation 
analysis data file.    This option sends the fragmentation analysis information to whatever printer is designated as 
your default printer.
This option is useful for comparing the condition of a partition before and after defragmenting the partition with 
Diskeeper.    See the Save Analysis help topic for information about saving the fragmentation analysis results.



Exclusion List

Use the Exclusion List option in the File menu to create a list of files or directories you want to be excluded from 
being defragmented.
Click here to see an example of the file exclusion list dialog box.



Exit

Use the Exit option in the File menu to completely exit from Diskeeper.    This option does not stop any 
defragmentation jobs that are running. This applies to both "Set It and Forget It" and "Manual Defragmentation" 
jobs.    If you exit while defragmentation jobs are running, the defragmentation run will continue until it is 
complete (in the case of "Manual Defragmentation" jobs) or until its scheduled completion time (in the case of 
"Set It and Forget It" jobs).



Analyze Menu

Use the options on the Analyze menu to control the analysis of fragmentation on your partitions.
The Analyze menu contains these options:

    Select Partition

    Continue

    Pause

    Stop



Select Partition

Use the Select Partition option in the Analyze menu to select a partition to be analyzed.
When you choose the Select Partition option, a list is displayed of the disk partitions detected on your computer. 
To select a partition, either click a listed partition and click OK, or simply double click the listed partition.    This 
starts the analysis immediately.



Continue

Use the Continue option in the Analyze menu to continue a previously paused fragmentation analysis of the 
selected partition.



Pause

Use the Pause option in the Analyze menu to temporarily pause the fragmentation analysis of the selected 
partition.



Stop

Use the Stop option in the Analyze menu to stop the fragmentation analysis of the selected partition.



Defragment Menu

Use the options on the Defragment menu to control the "Manual Defragmentation" of your partitions.
The Defragment menu contains these options:

    Select Partition

    Continue

    Pause

    Stop



Select Partition

Use the Select Partition option in the Defragment menu to select a partition to be defragmented.
When you choose the Select Partition option, a list is displayed of the disk partitions detected on your computer. 
To select a partition, either click a listed partition and click OK, or simply double click the listed partition.    This 
starts the defragmentation of the partition immediately, unless a previously scheduled defragmentation run is 
actively defragmenting the partition.



Continue

Use the Continue option in the Defragment menu to continue the previously paused defragmentation of a selected 
partition.



Pause

Use the Pause option in the Defragment menu to temporarily pause the defragmentation of the selected partition.



Stop

Use the Stop option in the Defragment menu to stop the defragmentation of the selected partition.



View Menu

Use the options on the View menu to display a text description of the fragmentation on the current partition, or to 
update the network tree display.
The View menu contains these options:

    Text

    Refresh (Diskeeper Server version only)



Text

Use the Text option in the View menu to display a text view of either a fragmentation analysis or the 
defragmentation of a partition.
Click here to see an example of the fragmentation analysis text display.



Refresh

Please note: This option is only available in the Windows NT Server version of Diskeeper.
Use the Refresh option to update the Diskeeper network tree display.    This is useful for times when computers 
join or exit from the network after you have started Diskeeper.



Options Menu

The Options menu contains these selections:

    Priority

    Event Logging

    Show Summary After Analysis

    Show Summary After Defragmentation

    Show Orientation on Launch



Priority

Use the Priority option in the Options menu to select the priority at which Diskeeper defragmentation jobs run.    
You can set the priority independently for both "Set It and Forget It" and "Manual Defragmentation" jobs.
The default priority for scheduled "Set It and Forget It" defragmentation jobs is “Lowest", while Manual 
Defragmentation jobs run at "Normal" priority. The priority for either type of defragmentation job can be changed 
with the Priority option.
Running at Lowest priority minimizes the system performance impact when Diskeeper is defragmenting a 
partition.    However, defragmentation jobs running at Lowest priority can take substantially longer to complete 
than those running at higher priorities, since Diskeeper "backs off" for any process running at a higher priority 
(even screen savers).
For this reason, you may have occasions where you want to run Diskeeper to complete a defragmentation job 
more quickly.    In these instances, use the higher priority options.      Keep in mind, though, that the performance 
of other applications running on your computer will probably be impacted when Diskeeper is run at higher 
priorities.



Event Logging

A log of Diskeeper activity is stored in the Windows NT Application Event Log file.
Use the Event Logging option in the Options menu to alternately enable and disable the logging of various 
Diskeeper events to the Windows NT Application Event Log.
When Diskeeper logs an event, the event and its message are appended to the Windows NT Application Event 
Log file, along with the date, time, user, and other identifying information.      These events can then be viewed 
with the Event Viewer by choosing the Application option in the Event Viewer Log menu.    This can be done on 
either local computers or remote computers on your network.
The Event Viewer is found in the Windows NT Administrative Tools group.
The Diskeeper Event Logging option displays this dialog box listing events for which logging can be enabled or 
disabled.    Click on the options shown below for descriptions of the information that is logged.

Click here for information on how to set up the Application Log.



Setting Up the Application Log

Diskeeper messages are placed in the Windows NT Application Event Log.    By default, this log is 512 
kilobytes in size, and is set to overwrite events older than 7 days old.    Diskeeper may quickly fill the log file 
if these default settings are used.    To prevent this, perform these steps to change the size and overwriting 
characteristics of the Application Event Log:

1 From the Windows NT Start button, choose Programs, then the Administrative Tools Program Group.
2 In the Administrative Tools Program Group, choose the Event Viewer.
3 In the Event Viewer, open the Log menu and choose the Log Settings option.
4 In the Event Log Settings dialog box, perform these steps:

n Set the Change Setting to Application Log.
n Set the Maximum Log Size to 2048 kilobytes.
n Enable the Overwrite Events as Needed option.
n Choose OK to return to the Event Viewer Log.



Setting Up the Application Event Log

Diskeeper messages are placed in the Windows NT Application Event Log.    By default, this log is 512 
kilobytes in size, and is set to overwrite events older than 7 days old.    Diskeeper may quickly fill the log file 
if these default settings are used.    To prevent this, perform these steps to change the size and overwriting 
characteristics of the Application Event Log:
1 From the Windows NT Start button, choose Programs, then the Administrative Tools Program Group.
2 In the Administrative Tools Program Group, choose the Event Viewer.
3 In the Event Viewer, open the Log menu and choose the Log Settings option.
4 In the Event Log Settings dialog box, perform these steps:

n Set the Change Setting to Application Log.
n Set the Maximum Log Size to 2048 kilobytes.
n Enable the Overwrite Events as Needed option.
n Choose OK to return to the Event Viewer Log.



Service Start and Stop

When this option is enabled, an entry is made to the Event Log each time the Diskeeper service starts or stops.    
This option is enabled by default.



Defragmentation Start and Stop

When this option is enabled, an entry is made to the Event Log whenever a defragmentation run starts or stops. 
This option is enabled by default.



Defragmented Files

When this option is enabled, an entry is made to the Event Log listing each file that is defragmented by 
Diskeeper.    Note that enabling this option can cause the Event Log to fill rather quickly, especially if Diskeeper 
defragments a high number of fragmented files.    (This will be particularly likely when Diskeeper is first run on a 
partition.)    This option is enabled by default.



Moved Files

When this option is enabled, an entry is made to the Event Log each time a file is moved for reasons other than to 
defragment the file.    This would include cases where files are moved in order to create more contiguous free 
space.    Here again, enabling this option can cause the Event Log to fill quickly. This option is not enabled by 
default.



Disk Information

When this option is enabled, an entry is made to the Event Log at the end of each defragmentation run showing 
general information about the disk partion that was defragmented.    This appears in the Windows NT Event 
Viewer as Diskeeper Event 15.    When you double click Diskeeper Event 15 in the Event Viewer, information 
similar to this example is displayed.    Click on any of the descriptions shown in the example below for more 
information about that description.    This option is not enabled by default.



File Information

When this option is enabled, an entry is made to the Event Log at the end of each defragmentation run showing 
information about the files on the disk partition that was defragmented.    This appears in the Windows NT Event 
Viewer as Diskeeper Event 16.    When you double click Diskeeper Event 16 in the Event Viewer, information 
similar to this example is displayed.    Click on any of the descriptions shown in the example below for more 
information about that description.    This option is not enabled by default.



Directory Information

When this option is enabled, an entry is made to the Event Log at the end of each defragmentation run showing 
information about the directories on the partition that was defragmented.    This appears in the Windows NT 
Event Viewer as Diskeeper Event 18.    When you double click Diskeeper Event 18 in the Event Viewer, 
information similar to this example is displayed.    Click on any of the descriptions shown in the example below 
for more information about that description.    This option is not enabled by default.



Paging File Information

When this option is enabled, an entry is made to the Event Log at the end of each defragmentation run showing 
information about the paging file on the partition that was defragmented (if it exists on the partition).    This 
appears in the Windows NT Event Viewer as Diskeeper Event 17.    When you double click Diskeeper Event 17 in 
the Event Viewer, information similar to this example is displayed.    Click on any of the descriptions shown in 
the example below for more information about that description.    This option is not enabled by default.



MFT Information

When this option is enabled, an entry is made to the Event Log at the end of each defragmentation run showing 
information about the Master File Table (MFT) on the partition that was defragmented.    (Keep in mind, since 
only NTFS partitions have an MFT, this information will only apply to NTFS partitions.)    The entry appears in 
the Windows NT Event Viewer as Diskeeper Event 19.    When you double click Diskeeper Event 19 in the Event 
Viewer, information similar to this example is displayed.    Click on any of the descriptions shown in the example 
below for more information about that description.    This option is not enabled by default.



Show Summary After Analysis

Use the Show Summary After Analysis option in the Options menu to alternately enable and disable a summary 
screen displayed after a fragmentation analysis.
This summary screen explains the condition of the analyzed partition, and makes recommendations based on the 
condition found.
Note that the summary screen includes information about the amount of free space available on the partition for 
defragmentation.    This figure is based on the space available to Diskeeper, but on NTFS partitions this is not 
necessarily the total free space on the partition.    A certain percentage of the total partition is reserved for the 
Master File Table (MFT) on NTFS partitions, and this space cannot be used by Diskeeper for defragmenting files. 
Because of this, the figure shown in the Diskeeper post-analysis summary on NTFS partitions will not match the 
total free space figure displayed in the Diskeeper text display (or other utilities like Disk Properties in Windows 
NT Explorer).



Show Summary After Defragmentation

Use the Show Summary After Defragmentation option in the Options menu to alternately enable and disable a 
summary screen displayed after a partition is defragmented.
This summary screen explains the condition of the partition after defragmentation, and describes any situations 
found which might prevent Diskeeper from completely defragmenting the partition.
The information presented in the summary is based on an analysis made before and after the defragmentation run.
Note that the summary screen includes information about the amount of free space available on the partition for 
defragmentation.    This figure is based on the space available to Diskeeper, but on NTFS partitions this is not 
necessarily the total free space on the partition.    A certain percentage of the total partition is reserved for the 
Master File Table (MFT) on NTFS partitions, and this space cannot be used by Diskeeper for defragmenting files. 
Because of this, the figure shown in the Diskeeper post-defragmentation summary on NTFS partitions will not 
match the total free space figure displayed in the Diskeeper text display (or other utilities like Disk Properties in 
Windows NT Explorer).



Show Orientation on Launch

Use the Show Orientation on Launch option in the Options menu to alternately enable and disable the Diskeeper 
orientation screen each time Diskeeper is started.
The Diskeeper orientation screen presents a "quick start" explanation of Diskeeper operation.



Set It and Forget It Menu

The Set It and Forget It menu contains these options:

    Partition Scheduler

    Network Scheduler (Diskeeper Server version only)



Partition Scheduler Option

Use the Partition Scheduler option in the Set It and Forget It menu to create a defragmentation schedule for 
one or more specific partitions.
Click here to see an example of the Set It and Forget It Partition Scheduling dialog box.
Use a defragmentation schedule to specify times when "Set It and Forget It" defragmentation jobs will be forced 
to run, or times they will not be allowed to run. 
Schedules only affect "Set It and Forget It" defragmentation jobs.    Any defragmentation job previously started 
on a partition will be safely stopped when a new run schedule is specified.
When you choose the Partition Scheduler option, always select the partition in the Partition List box before 
clicking on any of the other Partition scheduler controls.
If you are using Diskeeper for Windows NT Server, note that to set or alter a run schedule on remote 
computers on your network, you must have sufficient permissions to edit a file in the Diskeeper directory on 
the remote computer.    See Troubleshooting Network Connections for more information.



Network Scheduler Option

Please note: This option is only available in the Windows NT Server version of Diskeeper.
Use the Network Scheduler option in the Set It and Forget It menu to create a defragmentation schedule for all 
the disk partitions on one or more specific computers, workgroups, or domains on your network. 
Click here to see an example of the Set It and Forget It Network Scheduling dialog box.
Use a defragmentation schedule to specify times when "Set It and Forget It" defragmentation jobs will be forced 
to run, or times they will not be allowed to run. 
Schedules only affect "Set It and Forget It" defragmentation jobs.    Any active defragmentation job previously 
started on a partition will complete.    After any previously started jobs complete, the new schedule takes 
effect.
When you use    the Network Scheduler, always select one or more computers, workgroups, or domains in the 
Machine List box before clicking any of the other Network Scheduling controls.    To select more than one item 
to schedule, hold the <Ctrl> key while clicking on the computers, workgroups, or domains listed in the 
Machine List box that you want to schedule.    Or, you can hold the <Shift> key to select a continuous list of 
items in the Machine List box.
Note that to set or alter a run schedule on remote computers on your network (with Diskeeper for Windows NT 
Server), you must have sufficient permissions to edit a file in the Diskeeper directory on the remote computer. 
See Troubleshooting Network Connections for more information.



Connect Menu

The Connect menu contains this option:

 Select Computer
Please note: This option is only available in the Windows NT Server version of Diskeeper.



Select Computer Option

Please note: This option is only available in the Windows NT Server version of Diskeeper.
Diskeeper for Windows NT Server can analyze fragmentation and control the defragmentation of partitions on 
computers connected to your network or partitions on your local computer.    You must specifically connect to 
a computer before using Diskeeper.
By default, the Network Connections dialog box is displayed each time Diskeeper is started.    Click OK to 
connect to the local computer or select a computer in the Connect To box to connect to another computer on 
your network.
After starting Diskeeper, you can change which computer you are connected to by clicking the Connect button 
on the toolbar or by choosing the Select Computer option on the Connect menu to control Diskeeper on other 
computers connected to your network.
Diskeeper for Windows NT Workstation or Diskeeper for Windows NT Server must also be installed on the 
remote computer.
When the Connect button is clicked or Select Computer option is invoked, the Network Connections dialog box 
is displayed. Click on the different areas of the dialog box sample shown below for information about that section 
of the Network Connections dialog box.

Choose the computer upon which you want to run Diskeeper, then click OK.    After the computer is 
connected, the name of the computer being controlled is displayed at the top of the main Diskeeper window.
After selecting the computer upon which to run Diskeeper, start analyzing or defragmenting any of the 
partitions on that computer in the same manner as running Diskeeper on a local computer.    All of the options 
available when running Diskeeper on a local computer are also available across a network.
Note that after rebooting your Windows NT system, you may need to wait several minutes for the Windows 
NT Browser to detect the available network computers before the listing of available computers on your 
network appears in the tree view section of the Diskeeper display.
Error messages are displayed if Diskeeper fails to connect to a network computer.



Connect To

This section of the Network Connections dialog box displays the name of the computer you are connecting to.
To connect to remote computers, double click on the computer name shown in the Scan for Available 
Computers section of the Network Connections dialog box.    Or, if you know the name of the remote computer 
you want to connect to, simply type the name of the remote computer in the Connect To edit box.



Help Button

Click Help for context-sensitive help about the Diskeeper network connection option.



OK Button

Click OK after selecting the computer to which you want to connect.



Cancel Button

Click Cancel to cancel any changes you have made to the Diskeeper network connection and return to the 
opening Diskeeper screen.    If no computer has been specified previously, Diskeeper will connect to the local 
computer.



Scan for Available Computers

When the Network Connections dialog box is first opened, this section displays the domains and workgroups 
detected on your network.
Double click on any of the domain or workgroup names listed to expand the display and show the individual 
computers within the domain or workgroup.
Double click an individual computer name to connect to that computer.    Alternatively, click on the individual 
computer name and click OK.



Troubleshooting Network Connections

Please note: This information only applies to the Windows NT Server version of Diskeeper.

Network Error Messages

Editing Exclusion Lists

Creating or Altering Defragmentation Schedules Across a Network 



Network Error Messages

If Diskeeper encounters any error while searching the network for computers, a pop-up error message is 
displayed.    After choosing the OK button in this message box, a list of the computers it did find is displayed. 
This list will minimally be the local computer.
The following circumstances can prevent Diskeeper from connecting to a network computer, thus causing the 
error message to be displayed:
n Diskeeper is not installed on the remote computer.
n The Diskeeper service has not been started on the remote computer.
n The Diskeeper main menu is open on the remote computer.
n There is a problem within the Windows NT network.
n You are not logged onto an account with Administrator privileges on the remote computer.
Also, if your computer does not have a network card installed or the network is not started, a message box is 
displayed stating that the network is not present or not started.



Editing Exclusion Lists

To edit exclusion lists on remote computers on your network, you must have sufficient permissions to edit a 
file in the Diskeeper directory on the remote computer.    If you do not have sufficient permissions, an error 
message is displayed stating that access is denied to the exclusion list.    If you cannot edit an exclusion list that 
you think you have permission to use, there are two likely possibilities:
n You logged on with a username that the target computer recognizes and a password that it does not 

recognize.    A common example is to log on to your computer as Administrator and then try to edit an 
exclusion list on a computer that has its own Administrator account established with a different password.

n Your computer and the remote computer do no share the same network protocol that is running on the 
target computer.



Creating or Altering Defragmentation Schedules Across a Network

To create or alter run schedules on remote computers on your network, you must have sufficient permissions 
to edit a file in the Diskeeper directory on the remote computer.    If you do not have sufficient permissions, an 
error message is displayed stating that access is denied to the run schedule.    If you cannot create or alter a run 
schedule that you think you have permission to use, there are two likely possibilities:
n  You logged on with a username that the target computer recognizes and a password that it does not 

recognize.    A common example is to log on to your computer as Administrator and then try to edit an 
exclusion list on a computer that has its own Administrator account established with a different password.

n Your computer is not running a protocol that is running on the target computer.



Empty List of Available Computers

In some instances, when you choose the Connect option in the Network menu, the list of available computers 
in the Network Connections dialog box may be blank.    This can occur shortly after rebooting your Windows 
NT computer. 
Note that after rebooting your Windows NT computer, you may need to wait several minutes for the Windows 
NT Browser to detect the available network computers before the tree view of available computers on your 
network appears, then use the Refresh option in the View menu to update the tree view display.    If the list of 
computers still does not contain computers you expect to see, there are several possible causes:
n One or more of the remote computers is not running.
n One or more of the remote computers is configured to be hidden from computer browsers.
n Your Browser service may not be started.
n One or more of the remote computers is in a domain that is not in the list of domains to be browsed.    Use the 

Network applet in the Windows NT Control Panel to reconfigure the Browser service.



Advanced Tools Menu

The Advanced Tools menu contains this option:

    Boot-Time Defragmentation



Boot-Time Defragmentation

Use the Boot-Time Defragmentation option in the Advanced Tools menu to:
§ Defragment the directories on a partition and consolidate them into a single location
§ Defragment the paging file (if one exists on the partition)
Boot-time defragmentation opens up larger areas of contiguous partition space for new file creation and 
modification.
Click here to see an example of the Boot-Time Defragmentation dialog box.
Several points about Boot-Time Defragmentation:
1 The Boot-Time Defragmentation feature relies on having a contiguous free space in which to move the 

directories and/or paging file on your partition.    Therefore, it is important to run Diskeeper in either the Set 
It and Forget It or Manual Defragmentation mode before running the Boot-Time Defragmentation.

2 Boot-Time Defragmentation moves the directories and/or paging file to the first available free space into 
which they will fit.    This can be any location on the partition.

3 Boot-Time Defragmentation is a one-time operation.    After it runs on a partition, it is not automatically reset 
to run again.    You must set it each time you want it to run on a partition.

4 It is safe to re-start your computer midway through the Boot-Time Defragmentation operation.    However, if 
you do so, you should use the Error Checking option in Drive Properties/Tools on the partition that was 
being processed when you restarted your computer, and enable both the fix and the scan options, or (if you 
are running from the Windows NT Command Prompt) run CHKDSK, using the /F and /R qualifiers.    This 
ensures the files and free space on the partition are correctly allocated.



Boot-Time Defragmentation Dialog Box

Click on the different controls in the dialog box shown below for information about that control.



Available Partitions

Use this section of the dialog box to specify the partition(s) upon which you want to consolidate the directories 
and/or the paging file.    You can select more than one partition at a time, but be aware that the partitions will be 
processed one at a time, and your computer    will be re-booted automatically after each partition is processed.    
This will substantially increase the time needed to complete the operation.
Always select at least one partition before choosing any of the other options in the Defragmentation dialog box.



Directory Consolidation

Check this box to defragment and consolidate the directories on the selected partitions the next time you re-boot 
your computer.
Note that the selected partitions must have enough contiguous free space to accommodate the directories. If that 
condition is not met when you check this box,    a warning message is displayed and the option is disabled. For 
this reason, it is recommended that you first run Diskeeper in the Manual Defragmentation mode on the selected 
partitions before using the Directory Consolidation option.



Run CHKDSK Before & After Defragmentation

Use this control to specify whether Windows NT CHKDSK is run (using the /F and /R qualifiers) before and after 
the Boot-Time Defragmentation operation.    Running CHKDSK adds time to the operation, but it can correct disk 
errors that otherwise would hamper effective defragmentation.
Note that if you enable this option and select more than one partition at a time for defragmentation, CHKDSK 
will run on each partition separately and cumulatively.    This is due to the nature of the Windows NT boot 
sequence.    For example, if you select partitions C:, D: and E: for Boot-Time Defragmentation and have the “Run 
CHKDSK Before & After Defragmentation” option enabled, the following sequence occurs:
§ CHKDSK on C:
§ Defragmentation on C:
§ CHKDSK on C:
§ CHKDSK on D:
§ Defragmentation on D:
§ CHKDSK on C:
§ CHKDSK on D:
§ CHKDSK on E:
§ Defragmentation on E:
§ CHKDSK on C:
§ CHKDSK on D:
§ CHKDSK on E:
As you can see, if you select multiple partitions for Boot-Time Defragmentation, the cumulative CHKDSK 
operations will mount up, thus considerably increasing the time needed for the entire re-boot operation.
Note: Running CHKDSK can potentially take many hours, especially on large partitions. Therefore, we strongly 
recommend running no more than one partition at a time, since we also recommend CHKDSK be run before and 
after.



Reduce Paging File Fragments

Check this box to defragment the Windows NT paging file in the selected partition the next time you re-boot your 
computer.
Note that the selected partitions must have enough contiguous free space to accommodate the paging file. If that 
condition is not met when you check this box,    a warning message is displayed and the option is disabled. For 
this reason, it is recommended that you first run Diskeeper in the Manual Defragmentation mode on the selected 
partitions before using the Reduce Paging File Fragments option.



Pause After Defragmentation

When enabled, this option causes the Boot-Time Defragmentation operation to pause after completion.    It 
remains in this paused state until you manually re-start your computer (by either pressing the Reset button or 
turning off the power switch).    If this option is not enabled, the Boot-Time Defragmentation operation pauses 15 
seconds (to allow you to read any messages on the monitor screen), then automatically re-boots your computer.



Summary File

Use the Summary File option to cause a text file to be written that summarizes the Boot-Time Defragmentation 
operation.
When this option is enabled, a default drive, directory, and file name are shown in the dialog box similar to this:

By default, the summary file is written to your floppy drive (A:).    This dialog box can be edited to specify 
another drive, directory path, and filename.    However, the summary file cannot be written to the partition upon 
which you are running the Boot-Time Defragmentation.



Close

Click Close after clicking Set to save any settings you have made and close the dialog box.



Cancel

Click Cancel to close the dialog box without making any changes.



Set

Click Set to enable the Boot-Time Defragmentation of one or more selected partitions.    When a partition has 
been set, it will be noted in the Available Partitions box.    Also use the Set button to change the characteristics of 
a previously set Boot-Time Defragmentation (such as enabling/disabling the Summary File option).
The next time the computer is re-booted, the Boot-Time Defragmentation operation will be run on any partitions 
that are set.
You must set a partition each time you want to run the Boot-Time Defragmentation ¾ partitions do not remain set 
after the operation has been run.



Clear

Click Clear to "un-set" any partition(s) that have been previously set for Boot-Time Defragmentation.



Help

Click Help to view context-sensitive help about using the Boot-Time Defragmentation feature.



Help Menu

The Help menu contains these options:

    Orientation

    Contents

    About



Orientation

Use the Orientation option to display the Diskeeper orientation opening screen.    This display presents a brief 
"quick start" of Diskeeper operation.



Contents

Use the Contents option to view the Table of Contents for the Diskeeper help system.



About

Use the About option to view the version number and other really interesting information about Diskeeper. 



Partition

This section of the fragmentation analysis display shows which disk partition is being analyzed.



Partition Size

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total amount of 
space on the partition.    This includes files and free space, as well as disk space used by the operating system 
(such as directory files and the Master File Table) but not reported in "Used Space".



Cluster Size

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the cluster size for 
the partition.    A disk cluster represents a number of disk sectors treated as a single unit. The entire disk is divided 
into clusters, each one a minimum increment of storage.



Used Space

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total amount of 
disk space (in kilobytes) currently occupied by files.    This does not include zero-length files, or certain files used 
by the operating system (such as directory files and the Master File Table).



Free Space

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total amount of 
free space on the partition.



Percent Free Space

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the percentage of 
space on the partition that is free.    This includes the free space in the area reserved for the Master File Table 
(MFT) on NTFS partitions.



Paging File Size

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the size of the 
paging file on the partition.    This section will display zero when no paging file is present.



Paging File Fragments

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the number of 
fragments the paging file (if it exists on the partition) is broken into.



Total Directories

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total number of 
directories present on the partition.



Fragmented Directories

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the number of 
fragmented directories on the partition.



Excess Directory Fragments

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total number of 
directory fragments on the partition.    Contiguous directories are not counted in this total, but each additional 
piece of any fragmented directory is counted.



Total Files

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total number of 
files on the partition.    This number does not include zero-length files or (in most cases) files less than one cluster 
in size on NTFS partitions.    Files less than one cluster in size may be included, depending on the file size and the 
cluster size.



Average File Size

This section of the fragmentation analysis or the Windows NT Event Log entry display shows the average size of 
all the files on the partition.    This number does not include any zero-length files or paging files.



Fragmented Files

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total number of 
fragmented files on the partition.



Excess Fragments

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the total number of 
file fragments on the partition.    Contiguous files are not counted in this total, but each additional piece of any 
fragmented file is counted.



Percent of Partition Fragmented

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the percentage of 
the disk partition that contains fragmented data.    For example, a figure of 33% indicates one-third of the space 
on the partition contains fragmented files.    This figure is a good overall indication of the state of fragmentation 
on the partition.



Average Fragments per File

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the average 
number of fragments per file on the partition.    This is a good index of how fragmented the files on the partition 
are.
If the average fragments per file figure is 1.00, the files are contiguous.    If the figure is 1.10, then 10% of the 
files, on average, are in two pieces.    1.20 means 20%, 1.30 means 30%, etc.    A figure of 2.00 means the files 
average two fragments each.    1.00 is the best figure attainable, indicating that all files or nearly all files are 
contiguous.



MFT Size

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the size of the 
Master File Table (MFT). 
Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions in the text analysis 
display, and appears as zeros in the Windows NT Event Log entry.



Number of MFT Records

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the number of 
individual file records found in the Master File Table (MFT).    This figure will not necessarily correspond with 
the number of files presently on the partition, since the file records remain in the MFT, even after a file is deleted.
Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions.



Percent of MFT In Use

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the percentage of 
the Master File Table (MFT) in use.
The MFT grows as the number of files on the partition increases, but is not reduced in size when files are deleted 
from the partition.
Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions.



MFT Fragments

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the number of 
fragments the Master File Table (MFT) is broken into.
Since the MFT is only used on NTFS partitions, this section is grayed out on FAT partitions.



Most Fragmented Files

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the directory path 
and filename of the 50 most fragmented files on the partition, and the number of fragments those files are in.    If 
these files are ones that users access frequently, the impact to your system performance may be greater than 
indicated by the Average Fragments per File figure.



Number of Fragments

This section of the fragmentation analysis display or the Windows NT Event Log entry shows the number of 
fragments associated with the most fragmented files on your partition.



Fragmentation Analysis Status Bar

When the fragmentation analysis is running, this section of the display shows the percentage of the analysis 
completed, and also displays a message indicating when the analysis is done.



Number of Defragmented Files

This section of the Windows NT Event Log shows the total number of files that were defragmented during a 
Diskeeper defragmentation run.



Number of Fragments Eliminated

This section of the Windows NT Event Log shows the total number of fragments that were eliminated during a 
Diskeeper defragmentation run.



What is Diskeeper?

Running under the Windows NT operating system, Diskeeper finds files that are not stored on the partition in a 
single location, but instead are scattered in pieces all over the partition.    Files in such a condition are referred 
to as fragmented files.      As Diskeeper finds such files, it safely moves the pieces of each file, so each file is in 
a single, contiguous space on the partition. 
Diskeeper can do this automatically in the background, while users are actively accessing data on the same 
partition.    Or, for those times when you want to defragment a partition now, Diskeeper provides a manual, 
high-priority defragmentation option.



Using the Diskeeper Help Internet Access

The Diskeeper Help system gives you the ability to jump directly from the running Help system to the Internet.    
This assumes, of course, that you have Internet access and a default Web browser or navigator on your system.    
When you click a text hotspot or button that links to the Internet, your Web browser or navigator is automatically 
started.



Software License Information

Copyright
This Software is owned by Executive Software International, Inc. and is protected by United States copyright 
laws and international treaty provisions.    Therefore, you must treat the Software like any other copyrighted 
material (e.g. a book or musical recording) except that you may either (a) make one copy of the Software 
solely for backup or archival purposes, or (b) transfer the Software to a single hard disk provided you keep the 
original solely for backup or archival purposes.    You may not copy the user documentation provided with the 
Software, except for your own authorized use.

U. S. Government Restricted Rights
The software and documentation are provided with RESTRICTED RIGHTS.    Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the 
Commercial Computer Software -- Restricted Rights at 48 CFR 52.227-19 as applicable.    Manufacturer is 
Executive Software International, Inc., 701 North Brand Boulevard, 6th Floor, Glendale, California 91203-
1242



Frequently Asked Questions 

The following topics list several questions often asked about Diskeeper. 
Why won  ’  t my disk partition defragment completely?   
Why doesn't Diskeeper move directories while Windows NT is running? 
Why doesn  ’  t Diskeeper defragment paging files while Windows NT is running?   
Why doesn  ’  t Diskeeper defragment the Master File Table?   
Why doesn't Diskeeper completely consolidate the free space on my partition? 
Why don't my files get moved to the beginning of the partition? 
Why don't some of my NTFS partitions appear in the Diskeeper Tree View? 
What are the "Stages" Diskeeper goes through to defragment my partition? 
How do I determine how often to run Diskeeper on my partition? 
Why don't my defragmentation jobs all start at the same time? 
Why doesn't the free space reported in the posts-analysis (or defragmentation) pop- up match what the Diskeeper 
text display shows? 
Why didn't the Boot-Time Consolidation move my directories?
Should I use Diskeeper on RAID arrays? 
Click here to visit Executive Software’s Web site for the latest Frequently Asked Questions:
{button Visit Executive Software,EF(`Connect.exe',"http://www.execsoft.com",1)} 
Note:    It is necessary for you to have the default Web browser or navigator defined on your computer before 
clicking on the button.



Why won't my partition defragment completely?

This can be the result of several situations:
n If your partition is extremely full, there may not be sufficient free space to effectively defragment the files.    

In this case, we recommend temporarily moving some of the files off the partition, particularly large files.    
This temporary measure often allows Diskeeper the "working room" it needs to complete the 
defragmentation process.    Also, this allows Diskeeper to defragment the free space on the partition, 
increasing the possibility that the temporarily-moved files can be moved back to the partition in a contiguous 
(or at least less fragmented) condition.

n Another cause of incomplete defragmentation is a fragmented paging file. Click here for more information 
on how to remedy this.

n A partition that has (at one time or another) been filled to capacity may have a severely fragmented Master 
File Table (MFT).    There is a White Paper entitled The Effects of Fragmentation on Windows NT File 
System Performance available from the Executive Software Web site that describes the causes and effects of 
MFT fragmentation.    To view or download this White Paper, start your Web browser or navigator and click 
here.

n Another situation that can prevent complete defragmentation of a partition is the existence of a large number 
of directories on the partition.    See Why doesn  ’  t Diskeeper move directories while Windows NT is running?   
for more information.

n Yet another cause for incomplete defragmentation can be a security access situation. It is necessary for both 
SYSTEM and ADMINISTRATOR to have full control over a file (or the directory folder it is in) in order for 
Diskeeper to have access to move the file. This is because the Diskeeper service runs under the 
Administrator account, and System access is necessary to safely defragment files.    This is a security feature 
that is governed by the Windows NT C2 security requirements.



Why doesn't Diskeeper move directories while Windows NT is running?

By its very design, Windows NT does not allow directories on a partition to be moved online (when the computer 
is running and the operating system is fully started).    This is due to data integrity issues related to the way 
Windows NT maintains directory information while Windows NT is active.    In its online mode, Diskeeper runs 
while other processes are active on the system, and therefore does not attempt to move directories online.    
However, Diskeeper does provide a method by which you can defragment and consolidate the directories on your 
partition at boot-time.    See Boot-Time Defragmentation for more information.



Why doesn’t Diskeeper defragment the Master File Table?

The Master File Table (MFT) is the area on an NTFS partition where Windows NT keeps all the information 
necessary for the operating system to retrieve files from the partition.    The MFT also contains information such 
as the file creation, modification, and backup dates and times.    In essence, the MFT contains everything 
Windows NT needs to know about the files on the partition.
Since the MFT is held open for exclusive use, Diskeeper is unable to move any pieces of this critical system file. 
Otherwise, data integrity would be jeopardized.



Why doesn’t Diskeeper defragment paging files while Windows NT is running?

Diskeeper cannot defragment paging files while Windows NT is running, since paging files must be open for 
exclusive use by Windows NT at all times.    However, a paging file can be defragmented during boot-time, 
before Windows NT has started up.    See Defragmenting Paging Files for information about handling paging file 
fragmentation. 



How can I handle paging file fragmentation?

The paging file is open for exclusive use by the Windows NT operating system.    Diskeeper cannot defragment 
any file that is open for exclusive use.    However, Diskeeper can defragment the paging file during boot-time, 
before Windows NT has started up.    See Defragmenting Paging Files for information about handling paging file 
fragmentation. 



Why doesn't Diskeeper completely consolidate the free space on my partition?

There are several factors that can prevent the free space on a partition from being defragmented:
n A fragmented paging file.    See How can I handle paging file fragmentation?  for more information.
n A large number of directories on the partition.    See Why doesn  ’  t Diskeeper move directories while Windows   

NT is running?  for more information.
n On NTFS partitions, a portion of the free space on a partition is reserved by Windows NT for the Master File 

Table (MFT).    See Why don't my files get moved to the beginning of the partition?  for more information.
It is important to know that having all of the free space in a single, contiguous piece provides very little (if any) 
performance benefit.    Free space fragmented into hundreds of pieces will impact disk performance, but free 
space that’s in a few pieces should not have any effect on the performance of your disk.



Why don't my files get moved to the beginning of the partition?

On NTFS partitions, Windows NT reserves a portion of the free space on a partition for the Master File Table 
(MFT).    This free space is usually most noticeable at the physical "beginning" of the partition (easily seen using 
the graphic fragmentation analysis display), but space is also reserved for use by the MFT in other areas of the 
partition.
Since Windows NT reserves this free space for exclusive use, Diskeeper will not move files into these areas of 
the partition. However, Diskeeper will move files out of this reserved area.



Why don't some of my NTFS partitions appear in the Diskeeper Tree View?

It is necessary for both SYSTEM and ADMINISTRATOR to have full control over a file (or the directory folder 
it is in)    in order for Diskeeper to have access to move the file. This is because the Diskeeper service runs under 
the Administrator account, and System access is necessary to safely defragment files. This is a security feature 
that is governed by the Windows NT C2 security requirements.
If the root-level directory folder does not have SYSTEM and ADMINISTRATOR set for full control (as seen in 
the Permissions section under the Security tab in the Properties dialog box) Diskeeper will not display the 
partition in the Tree View under some circumstances.



What are the "Stages" Diskeeper goes through to defragment my partition?

As Diskeeper analyzes or defragments your partition, the lower portion of the Diskeeper display shows several 
numbered "Stages" as they progress. 
The analysis operation consists of two stages.    Stage 0 gathers general information about the number of files and 
file fragments on the partition. Stage 1 gathers additional, more specific, information and displays the information 
found.
The defragmentation operation is a bit more complex.    First, it runs an analysis of the partition (Stages 0 and 1 of 
the analysis).    After the analysis, Diskeeper uses up to seven separate stages, each of which employs a separate 
proprietary algorithm to optimally defragment your partition.    Then, after the defragmentation stages are 
complete, the partition is re-analyzed to ensure the display is updated.



How do I determine how often to run Diskeeper on my partition?

There are no set rules on how often you should defragment your disk partitions.    There are many variables that 
control this, including the level of file activity on your partition, the size and types of files used on the partition, 
and the amount of free space available on the partition.
However, there are some general guidelines.
n Disks on busy file servers should be defragmented more often than those on single-user workstations.    You 

may need to run Diskeeper on a server partition as often as every two to four hours to maintain the optimum 
performance from your Windows NT system.    On a workstation partition though, you may only need to run 
Diskeeper daily.

n To determine how often to run Diskeeper on your partitions, you can use the logging function of Diskeeper 
to monitor the number of files moved during each Diskeeper run.    See Event Logging for information about 
logging the names of files that get moved by Diskeeper.

n In general, if Diskeeper is moving fewer than 50 files per run, you are running Diskeeper frequently enough. 
Diskeeper is maintaining the performance of your Windows NT system at an optimum level.    If the number 
of files moved during each run is more than 50 or so, or is increasing, schedule Diskeeper to run more 
frequently.



Why don't my defragmentation jobs all start at the same time?

Diskeeper is designed to defragment more than one disk partition at a time.    However, when the defragmentation 
of two or more partitions is scheduled to begin at the same time, Diskeeper will start each job separately, in one-
minute intervals.    For this reason, you will notice the start times for each Diskeeper job run in the Application 
Event Log can vary by several minutes.    This is no cause for alarm.



Why doesn't free space reported in the post-analysis (or defragmentation) pop-up match 
what the Diskeeper text display shows?

Several of the post-analysis and post-defragmentation summary screens include information about the amount of 
free space available on the partition for defragmentation.    This figure is based on the space available to 
Diskeeper, but on NTFS partitions this is not necessarily the total free space on the partition.    A certain 
percentage of the total partition is reserved for the Master File Table (MFT) on NTFS partitions, and this space 
cannot be used by Diskeeper for defragmenting files.    Because of this, the figure shown in the Diskeeper post-
analysis and post-defragmentation summaries on NTFS partitions will not match the total free space figure 
displayed in the Diskeeper text display (or other utilities like Disk Properties in Windows NT Explorer).



Why didn't the Boot-Time Consolidation move my directories?

The Boot-Time Consolidation feature requires enough contiguous free space to contain the directories on the 
partition.    For this reason, you should run Diskeeper in one of its online modes before running the Boot-Time 
Consolidation.
Also, keep in mind that there are two directories that cannot be safely moved, even at boot-time.    The directories 
are \Recycler and \Recycled.    Because these two directories cannot be moved, the Boot-Time Consolidation 
operation will likely still leave one or two directories that are not consolidated with the rest of your directories.



New Features!
Diskeeper 4.0’s major enhancement over its predecessor, Diskeeper 3.0, is that it permits paging file 
defragmentation. This greatly increases the effectiveness of disk defragmentation.



Safety

Diskeeper is designed with SAFETY as the highest priority.
To ensure the safe movement of files on the disk, Diskeeper 4.0 uses mechanisms built into Windows NT 4.0 that 
were developed and implemented by Executive Software, and fully incorporated into Windows NT by Microsoft.
By using these built-in mechanisms, Diskeeper maintains cache coherency, file security and permissions 
information, and file content integrity no matter how fragmented the files on the disk are.
The foremost design goal for Diskeeper for Windows NT was to make sure that no data is ever lost.    To 
accomplish this goal Diskeeper uses the following criteria for accessing files:
n the contents of data files are never modified under any circumstances
n only one file is processed at a time, not the whole partition
n each processing pass is independent of the other passes
n no information is stored on any other device or in a "scratch space"
n Diskeeper accesses a file in such a way that no user access can conflict with Diskeeper during the critical 

portion of the relocation process
n file relocation is aborted if any error is encountered, leaving the file in its original state
Diskeeper was designed to err on the side of caution.    In other words, it only moves a file on the partition 
when it is absolutely certain that no data will be lost, including file attributes.    The only change to file 
attribute-type information is the physical location of the file on the partition.    None of the file dates are 
changed and no other fields in the file record header are used to store Diskeeper information.
Diskeeper never defragments or moves files that are specifically stored at a specific physical location on the 
partition.
If anything causes your computer to crash while Diskeeper is running, or if you abort the Diskeeper 
defragmentation run in the middle of the file relocation process, no data is ever at risk.
It is no wonder that Diskeeper is the preferred defragmenter, found on the computer systems at NASA, 
McDonnell Douglas, Lockheed, Boeing, AT&T, Unisys, Bechtel, E. I. Dupont, Northrop, Caterpillar, and many 
other companies. 



Process Live Disks

It is not acceptable to force users off the disk while performing routine defragmentation.    To do so would be a 
case of the cure being worse than the disease.    Access to fragmented files is better than no access at all.
The best solution is to defragment on-line with users active on the same disk.    Diskeeper was designed with this 
in mind.    During most of the time Diskeeper is processing a file in its on-line mode, Diskeeper shares the file 
with any other users that may access the same file.    The last step of processing the file, however, involves 
locking the file for a very brief period, a matter of milliseconds.    If another user requests a file that Diskeeper 
has locked, that request is suspended for the brief period until Diskeeper releases the file.    Then the request is 
serviced.    There is never an interruption of either process as a result of this delay.
This solution allows Diskeeper to safely defragment most open files, whether they are open for read operations or 
for write operations.
Note: Due to the Windows NT design, directories and paging files cannot safely be moved on live disks. 
Therefore, Diskeeper performs these operations at the only safe time, while the computer is booting.



Performance

When running in the "Set It and Forget It" mode, Diskeeper is designed to run in the background, without 
adversely affecting performance of your Windows NT computer.    Steps have been taken to assure that by 
default, Diskeeper overhead has the lowest possible impact on system performance.    Diskeeper can be run at the 
lowest possible priority, using only otherwise unused CPU cycles.    Diskeeper was designed in such a way to 
ensure it will not interfere with other processes on your Windows NT computer.
However, for cases where you want to defragment partitions more quickly, Diskeeper allows you to increase the 
defragmentation priority.    Click here for more information about setting the priority for a Diskeeper 
defragmentation job.



No Operator Intervention

In keeping with the design goals, once Diskeeper has been started in the "Set It and Forget It" mode, it runs 
automatically in the background, without the need for operator intervention.    It runs indefinitely, unless told 
otherwise by you.



Efficiency

In its automatic, "Set It and Forget It" mode, Diskeeper for Windows NT is very efficient, using only otherwise 
unused CPU cycles to perform its work.
A one key design criterion was for the defragmentation process to use fewer resources than using the partition in 
a fragmented condition.    This criterion has been met in the full version of Diskeeper for Windows NT.



Recording What Diskeeper Does

Diskeeper provides a vast amount of information that you save to disk in one of two ways:    You can save the text 
results of an analysis of your partition, or you can record defragmentation results and other partition information 
in the Windows NT Event Log.
Click here for information about saving the text results of an analysis.
Click here for information about recording Diskeeper information in the Windows NT Event Log.



Defragmenting a Disk Partition

Diskeeper can defragment your disk partitions in two ways:    You can run Diskeeper manually, or run it in the 
scheduled, Set It and Forget It mode.
Click here for information about running Diskeeper in the Manual Defragmentation mode.
Click here for information about running Diskeeper in the Set It and Forget It mode.



Defragmenting Across a Network

The Windows NT Server version of Diskeeper allows you to defragment disk partitions on all the computers in 
your network (assuming, of course that Diskeeper is installed on the remote computers).    There is no need for 
you to run around to every computer on the network ¾ you can do it all from your desk.
Click here for information about scheduling Diskeeper to run on all the computers on your network



Defragmenting Directories

By its very design, Windows NT does not allow directories on a partition to be moved online (when the computer 
is running and the operating system is fully started).    This is due to data integrity issues related to the way 
Windows NT maintains directory information while Windows NT is active.    In its online mode, Diskeeper runs 
while other processes are active on the system, and therefore does not attempt to move directories.    However, 
Diskeeper does provide a method by which you can defragment and consolidate the directories on your partition 
at boot-time.
Click here for more information about the Diskeeper Boot-Time Defragmentation feature. 



Defragmenting Paging Files

By its very design, Windows NT does not allow a paging file on a partition to be defragmented online (when the 
computer is running and the operating system is fully started).    This is due to data integrity issues related to the 
way Windows NT maintains the paging file.    In its online mode, Diskeeper runs while other processes are active 
on the system, and therefore does not attempt to move the paging file.    However, Diskeeper does provide a 
method by which you can defragment the paging file on your partition at boot-time.
Click here for more information about the Diskeeper Boot-Time Defragmentation feature. 



Getting the Most from Diskeeper

Diskeeper provides a variety of features, all of which are designed to help you get the best performance from 
your computer.    While there are no "hard and fast" rules governing the use of Diskeeper, here are some general 
guidelines about using these features that will help you get the most from Diskeeper.
When you first install Diskeeper, analyze all the disk partitions on your computer.    This gives you good 
information about the extent of fragmentation on your computer.    See Analyzing Fragmentation for more 
information.
After you have analyzed your partitions, defragment them by running Diskeeper in its Manual Defragmentation 
mode.    This provides the fastest, highest-priority method for defragmenting the files and free space on your 
partition.    See Manual Defragmentation Mode for more information.
After you’ve run Diskeeper in its Manual Defragmentation mode for the initial file and free space 
defragmentation, it’s time to handle the directories that are scattered all over your partitions.    To do this, use the 
Diskeeper Boot-Time Defragmentation feature.    Since directories cannot be moved while your computer is fully 
up and running, the Boot-Time Defragmentation defragments and consolidates the directories on your partitions 
while your computer is booting.    It is important to defragment your partitions before running the Boot-Time 
Defragmentation in order to create a contiguous free space for your directories to be moved into.    See Boot-Time 
Defragmentation for more information.
Once your directories have been consolidated, schedule Diskeeper to run in the background in its Set It and 
Forget It mode.    Running in the Set It and Forget It mode, Diskeeper works in the background, keeping your 
disks in prime condition.    See Set It and Forget It Mode for more information.



U.S. Technical Support

Registered users are entitled to 90 days of free telephone support, as well as special upgrade pricing, from 
Executive Software.    Our free U.S. technical support is available Monday through Friday during the first 90 days 
from 7:00 A.M. to 5:30 P.M. Pacific time.    If you have not yet registered your Diskeeper for Windows NT 
purchase, use the registration card in your Diskeeper box and do so now.    Or, register your purchase on-line via 
our Web site at:
http://www.execsoft.com
Click here to visit Executive Software’s Web site:
{button Visit Executive Software,EF(`Connect.exe',"http://www.execsoft.com",1)} 
Most technical support questions can be answered from the Technical Support    section of our Web site at the 
address shown above.
You may also contact our technical support team via the Internet at:
dknt_support@executive.com 
or via FAX at:
818-545-9241
Executive Software also makes available unlimited technical support assistance via its support forum on 
CompuServe.    GO EXECSOFT to access this forum.
If you are within your 90 day free support period, or have purchased telephone support, you can call:
818-547-2050
When your 90 day free support period has expired, you may purchase the support plan which best suits your 
needs.    Executive Software offers 24-hour, 7-day support plans.    Contact Executive Software to find out which 
support options are best for you.
Executive Software's address is:
Executive Software
701 North Brand Blvd., 6th Floor
Glendale, California, USA      91203-1242
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A
access 
administrator 
Alpha 
applet 
application 
AutoPlay 
B
background processing 
binary 
bit 
boot 
boot-time 
byte 
C
cache



cache coherency
cache memory
CD-ROM 
central processing unit 
chip 
CHKDSK 
client 
cluster 
contiguous 
control file 
controller 
CPU 
D
data 
database 
datum 
defragmentation 
device 
digit 
directory 
directory consolidation 
disk drive 
Diskeeper 
diskette 
domain 
drive 
drive letter 
E
event logging 
Event Viewer 
extended partition 
F
FAT 
FAT file system 
field 
file 
file allocation table 
file system 
floppy disk 
formatting 
fragmentation 
G
graphical user interface 
GUI 
H
hard disk 
hardware 



I
IDE 
integrated circuit 
Intel 
interface 
J
job 
K
No Glossary entries.
L
log file 
logical drive 
M
master file table 
media 
medium 
memory 
MFT 
Microsoft 
MS-DOS 
multitasking 
N
network 
network scheduling engine 
NTFS 
O
operating system 
P
paging file 
partition 
Pentium 
peripheral device 
permission 
platform 
platter 
primary partition 
priority 
process 
processor 
program 
Q
No Glossary entries.
R
RAID 
record 
registry 
resource 



S
SCSI 
server 
service 
Service Pack 
Set It and Forget It 
SMS 
software 
system 
system administrator 
system file 
T
task 
U
utility 
V
volume set 
W
Windows 
Windows NT 
workgroup 
workstation 
X
x86 
Y
No Glossary entries.
Z
No Glossary entries.



access

To store data on, or retrieve data from, a disk drive or other peripheral device. See also file.



Alpha

Alpha is both a high-speed processor and a computer system made by Digital Equipment Corporation (DEC.) 
The Alpha processor is a RISC (Reduced Instruction Set Computer,) which has a small set of simple instructions, 
rather than a large set of complex instructions. This has the advantage of much higher processor speeds, because 
the processor is much simpler and smaller. The tradeoff is that some of the work that would otherwise be done by 
the processor now has to be done by software.



applet

A small application program that is usually built into an operating system or a larger application program. For 
example, the built-in writing and drawing programs that come with Windows are sometimes called "applets." 



application

A computer program , which causes a computer system to perform some useful work for the user.



AutoPlay

A feature of some Windows applications on CD-ROM to execute automatically when placed in the drive, or when 
present in the drive at start-up. 



background processing

The execution of certain operations during momentary lulls in the primary (foreground) process . An example of 
a background process is printing while a word processor is waiting for keystrokes.



binary

From Latin “bini,” meaning two by two and “ary,” meaning of, or pertaining to. Computers use the binary 
number system, which is a way of counting in which only two digits (0 and 1) are used. Contrast with the familiar 
decimal number system, in which we count with 10 digits (0 through 9.)



bit

Short for binary digit. The smallest unit of information handled by a computer. Like a light switch, a bit is either 
on or off, which corresponds to a numerical value of one or zero. Larger numbers are expressed by groups of bits. 
See also byte.



boot

Refers to the initial start-up of a computer, such as when you turn on the computer’s power. From the word 
“bootstrap,” indicating the computer “lifts itself by its bootstraps”; that is, it gets itself going.



boot-time

The time during which a computer boots; that is, the computer is starting up and the operating system has not yet 
taken over control of the computer.



byte

A group of eight bits, which can represent a number from zero through 255, a letter of the alphabet, or a variety 
of other things.



CD-ROM

Compact Disk Read-Only Memory. A stiff plastic disk commonly used by software manufacturers to distribute 
software to customers. As the name implies, the original contents of a CD-ROM cannot be changed.



central processing unit (CPU)

The part of the computer hardware that controls the computer’s overall operation and performs computations. 
Most modern CPUs are built into a single integrated circuit (chip.) See also AlphaAlpha, Pentium, x86. 



chip

See integrated circuit .



CHKDSK

A program that checks the integrity of a disk and corrects disk errors such as lost clusters.



client

In a computer network, a computer that uses the services of another computer, called a server. For example, a 
client can “ask” a server to provide it with needed data, or to print a file for the client. See also server, 
workstation.



cluster

Smallest addressable unit of space on a disk. A one-byte file will actually use a cluster of disk space. The 
minimum size of a cluster depends on the size of the disk partition. The FAT file system allows a maximum of 
65,536 clusters per partition (16 bits,) which means that the cluster size on a 64-megabyte disk partition is one 
kilobyte, while a 128-megabyte partition uses two-kilobyte clusters. Thus, the FAT file system can be very 
wasteful of disk space on large partitions. The NTFS file system does not suffer from this limitation.



contiguous

Adjacent; placed one after the other. A contiguous file is not fragmented; that is, it takes up a single “chunk” of 
disk space. See also fragmentation, defragmentation.



control file

A file (Diskeep.ctl) used by Diskeeper to keep track of and control scheduled defragmentation of disk partitions. 
See also Set It and Forget It.



controller

A specialized electronic circuit, which serves as an interface between a device, such as a disk drive, and a 
computer. See also IDE, SCSI.



CPU

Short for central processing unit.



data

Information, as processed by a computer. Plural of the Latin word datum, meaning an item of information.



database

A collection of related information about a subject, organized in a useful manner that provides a base or 
foundation for procedures such as retrieving information, drawing conclusions, and making decisions. 



datum

Singular of data.



defragmentation

The reduction or elimination of fragmentation, by making files and/or free disk space more contiguous.



device

A machine, such as a printer or a disk drive.



digit

From Latin “digitus,” meaning finger. Any of the numbers 0 through 9 in the decimal number system, called a 
digit because people originally used their fingers for counting. Computers use a binary number system, which 
uses only two digits (0 and 1.)



directory

A file that contains a catalog of files and other directories stored on a disk, which allows you to organize your 
files into groups, making them easier to find.



directory consolidation

A Diskeeper feature which, at boot-time, gathers (almost) all directory entries on a disk partition into a single area 
on the disk, instead of scattered in many places. The only exceptions are the \Recycler and \Recycled directories, 
which Windows NT expects to find at a fixed location on the partition. Directory consolidation makes 
defragmentation more effective than it would otherwise be. Directory consolidation requires sufficient contiguous 
free space into which the directories can be moved.



disk drive

A device containing one or more disks, treated as a unit by a computer.



Diskeeper

A software product that increases system performance through disk defragmentation.    It safely eliminates 
resource-wasting file fragmentation by consolidating fragmented files and free space. Diskeeper for Windows 
NT is available both in workstation and server versions.



diskette

See floppy disk.



domain

In Windows NT, a group of workstations and servers, defined by an administrator, that share a common directory 
database and allow a user to log onto any resource in the domain with a single user ID and password. Each 
domain in a network has a unique name.



drive

See disk drive.



drive letter

In Windows and MS-DOS operating systems , the naming convention for disk drives, consisting of a letter, 
followed by a colon. Drives A: and B: are normally reserved for floppy disk drives and C: typically indicates the 
first hard drive. See also partition.



event logging

The Windows NT process of recording audit information when certain events occur, such as services starting and 
stopping, users logging on and off and accessing resources. Logged events can be viewed with the Event Viewer 
utility (in Administrative Tools.) 



Event Viewer

A Windows NT utility, which permits the viewing of logged events. See also event logging. 



extended partition

A type of partition that permits the limitation of four partitions per disk drive to be overcome. A disk drive may 
be partitioned into a maximum of four primary partitions, or three primary partitions plus an extended partition. 
One or more logical drives may be created within an extended partition.



FAT

See file allocation table. 



FAT file system

The file system used by MS-DOS and adapted for Windows NT to store information on disks, which makes use 
of a file allocation table.



field

A subdivision of a record in a file. For example, a record in a customer file may contain a 
name field, an address field and a phone number field.



file

A complete, named collection of data, such as a program , a set of data used by a program, or a user-created 
document. See also record, field.



file allocation table (FAT)

A table or list maintained by some operating systems, to keep track of how files are stored on a disk.



file system

The method used by an operating system, of naming, accessing and organizing files and directories on a disk. See 
also NTFS, FAT file system.



floppy disk

A removable storage medium , consisting of a small magnetic disk made of flexible plastic, housed in a square 
protective envelope or cartridge. Originally, floppy disks really were ”floppy,” because they were enclosed in a 
paper envelope. Also called a diskette, which is a better name for the more recent design that uses a stiff plastic 
cartridge. Contrast with hard disk.



formatting

A method of preparing a disk surface for use by placing certain magnetic patterns on it, which are used by the file 
system in storing and retrieving data. 



fragmentation

The word fragmentation means “the state of being fragmented.” The word fragment means “a detached, isolated 
or incomplete part.” It is derived from the Latin “fragmentum,” which in turn is derived from “frangere,” 
meaning “break.” So, fragmentation means that something is broken into parts that are detached, isolated or 
incomplete.



graphical user interface (GUI)

Pronounced “gooey.” A user interface, as used in the Windows and Windows NT operating systems, which uses a 
mouse and graphic displays to interact with the user, with the purpose to make the computer system easier to use 
than other operating systems, such as MS-DOS.



hard disk

One or more rigid metal platters, coated with magnetic material. Contrast with floppy disk, or diskette, which is 
made of plastic. Also used to refer to the physical unit that makes up a disk drive.



hardware

The physical parts of a computer system , including devices such as printers and disk drives. Contrast with 
software.



IDE

Integrated Device Electronics. One of two common types of interfaces between a disk drive and a computer, 
where the controller is built into the disk drive or into the computer’s main board, which eliminates the need for a 
separate controller card in the computer. See also SCSI .



integrated circuit

Also called a chip. A collection of electronic parts with a specific purpose, built into a single physical package. 
See also central processing unit.



Intel

Manufacturer of processor chips, known especially for the Pentium and x86 processors.



interface

The connection and interaction between hardware, software and/or the user. For example, a disk controller 
provides a physical interface between a computer and a disk drive. The keyboard, mouse and display are an 
interface between a computer and the user.



job

A request to have the computer or its peripherals perform some activity. In relation to Diskeeper, it is a request to 
have a disk defragmented.



log file 

A file that keeps track of certain events as they occur. The Windows NT operating system maintains several log 
files that can be viewed with the Event Viewer. See also Event Logging.



logical drive

That portion of the space on a disk drive that is considered by the software to be a single unit. In this context, 
logical means “conceptual.” because there is no direct relationship between the name and a physical object. See 
also partition.



master file table (MFT)

On an NTFS partition, the master file table is a file, which contains information about all other files in that 
partition. This includes the name of each file, its physical location on the disk, and other information.



media

A collective word for the physical material on which computer-based information is stored, such as a CD-ROM 
or floppy disk. Media is the plural of medium, but like data is often used in the singular form.



medium

Singular of media.



memory

The computer’s temporary working storage, where program instructions and data are kept, permitting the CPU to 
process the instructions.



MFT

See master file table.



Microsoft

A computer software company, with its head office in the state of Washington; creators of the MS-DOS and 
Windows operating systems.



MS-DOS

Microsoft Disk Operating System. An operating system designed for a small computer with a single user running 
one application program at a time.



multitasking

A feature of an operating system, where the computer can work on more than one task at a time. See also 
background processing.



network

A group of computers that are connected together and capable of exchanging data with each other. See also 
server, client.



network scheduling engine

A process, generated by Diskeeper, which performs the work of updating the Diskeeper control files on one or 
more remote computers, without the need for you to individually connect to each computer.



NTFS

New Technology File System. A file system designed specifically for use with Windows NT.



operating system

A collection of programs, which performs system functions and controls the running of application programs and 
the allocation of resources. 



pagefile

See paging file.



paging file

An area of a disk that is set aside to hold data intended to reside in the computer’s memory. Portions of the 
paging file are copied to memory as needed. This mechanism requires a much smaller amount of physical 
memory than would be required if the entire program were to be loaded into memory all at once.



partition

A subdivision of the space on a disk drive that is treated as though it were a separate physical unit. A computer 
with only one hard disk drive can have a single partition, often called drive C:, or it can have several partitions, 
such as drive C:, drive D:, and drive E:. See also drive letter, primary partition, extended partition, logical drive.



Pentium

The name of a type of processor, introduced by Intel in 1993. It is the successor to the 80486 and equivalent to 
the 80586 chip in the x86 series.



peripheral device

(Related to periphery, roughly meaning “on the outside.”) A device, such as a disk drive or printer, keyboard or 
mouse, connected to and used by a computer. 



permission

The ability of a user on a computer system to access or modify files, especially those that he or she did not create. 
Permissions exist for security reasons, to prevent unauthorized access to sensitive information. The system 
administrator assigns permissions, or “who has access to what.”



platform

The environment, in which a computer system operates, either based on the computer’s CPU or its operating 
system. For example: the x86 platform, or the Windows NT platform.



platter

A disk drive consists of one or more platters, each of which can receive magnetic recordings on both sides. The 
platter spins like a phonograph record on a turntable. 



preemptive multitasking

Also called time-slice multitasking. A form of multitasking in which the operating system periodically interrupts 
the execution of a program and passes control of the system to another waiting program. Preemptive multitasking 
prevents any one program from monopolizing the system.



primary partition

In Windows and MS-DOS operating systems, the disk space on a disk drive may be divided into a maximum of 
four primary partitions; or three primary partitions plus an extended partition, which in turn can contain one or 
more logical drives.



priority

On a Windows NT system, several programs can appear to be running at once, even though the CPU can only 
process one instruction at a time. With the help of the operating system , the CPU processes a few instructions 
from one program, then a few instructions of the next program, and so on, over and over. Without priority 
assignments, each program would be given about the same amount of time in each “time slot”, but by assigning 
priorities, the more important programs can be given longer time intervals than the less important ones, allowing 
them to complete faster.



process

A program, along with the system resources the program requires to run. A process represents a unit of resource 
ownership and work to be done. The operating system creates processes to keep track of resources and to ensure 
the proper scheduling of tasks.



processor

See central processing unit.



program

A set of instructions that tell a computer what to do. Synonym: software.



RAID

Redundant Array of Independent Disks. A method of combining several disk drives to make one large partition. 
Typically used on a network file server to achieve faster access, greater protection against disk failure, or both. 



record

A collection of related data items, treated as a unit. For example, in a file containing information about a 
company’s customers, one record would consist of the particulars (name, address, phone number, etc.) of one 
customer. See also field. 



registry

A database that contains information about current hardware settings, installed software, user preferences and 
associations between file types and applications that access those files.



resource

Any part of a computer system, such as a disk drive, printer, or memory, which can be used by a program.



SCSI

Small Computer System Interface. One of two common methods of interfacing disk drives and other devices to 
computers. See also IDE.



server

On a computer network, a computer that makes resources available to other computers (clients or workstations.) 
For example, all the computers on a network can be set up to share a single high-speed printer, which is 
connected to the server. Usually, the server is faster and more powerful than the client computers connected to it.



service

A process that performs a specific system function and often provides an application programming interface 
(API) for other processes to call. Diskeeper uses a Windows NT service, which allows Diskeeper to run in the 
background while other applications are running.



Set It and Forget It

A term that was created by Executive Software and is a registered trademark and hallmark of the company.    A 
"Set It and Forget It" product can operate transparently (unseen by the user) and in the background (concurrent 
with other applications).    Once a schedule is set up for its operation, it thereafter performs its functions at 
predetermined times, without further intervention or attention from the user or administrator.



software

A generic term for computer programs, taken collectively. Contrast with hardware. Software can be categorized 
into application software and system software.



SMS

System Management Server. A software product from Microsoft, which permits the system administrator on a 
Windows NT network to do such things as install and run new software on different computers on the network, 
all from a single location.



system

The collection of one or more computers and peripheral devices. Sometimes used as a synonym for operating 
system, or the combination of hardware and software, as a logical unit.



system administrator

The person in charge of maintaining a multi-user computer system .



system file

In general, a file that is part of, or accessed by, the operating system. Diskeeper’s graphic analysis display shows 
certain system files in green, particularly the master file table (MFT) and several other files that cannot safely be 
moved by Diskeeper (or any other defragmenter). These are not the files that make up the Windows NT operating 
system , but the files that make up the NTFS file system.



task

A program or portion thereof that is run as an independent entity.



utility

A program that provides basic services or functions.



volume set

In Windows NT, a single logical drive, which is composed of up to 32 areas of free space on one or more disk 
drives. Volume sets can be used to combine small areas of free space on one or more disk drives into a larger 
logical drive, or to create a single large logical drive out of two or more small disks.



Windows

An operating system introduced by Microsoft in 1983, with a graphical user interface and which runs on MS-
DOS based computers. See also Windows NT.



Windows NT

An operating system released by Microsoft in 1993 (NT stands for New Technology.) It has a similar graphical 
user interface to Windows , but it does not run over MS-DOS and has been designed specifically for computer 
network environments.



workgroup

In Windows NT, a workgroup consists of one or more computers that do not participate in a domain and are 
therefore responsible for their own security and administration.



workstation

A computer that has been set up for use by an individual typically connected to a network. The term is also used 
to indicate a client computer, in contrast with a server.



x86

Symbol to represent a series of CPUs, manufactured by Intel and others, including model numbers 8086, 80286, 
80386, 80486 and 80586 (Pentium.) All of the CPUs in this series have certain characteristics in common, which 
permits software to be written that will run on any of them. 



That's Us!
The following people all had hands-on participation in the development of Diskeeper 4.0:
n Raffi Abnous 
n Grant Akopyan 
n Joan Barnes 
n Myron Chew 
n Jane Davey 
n Ernest Duran 
n Zack Gainsforth 
n John Joseph 
n Sopurkh Khalsa 
n Mark Kirby 
n Bert Kleinschmidt 
n Tim Lathrop 
n Vaughn McMillan 
n The Three Musketeers 
n Gary Quan 
n Andy Staffer 
n Peter Verhoeff 
. . . and many others, especially field test sites, to whom we say thank you! 



Raffi

Raffi is one of the famed "Three Musketeers".    He is also known as the "Orkin Man", since he enjoys eradicating 
bugs.    He’s the real golfer of the group (the rest of us are beginners compared to him), and he's our official putting 
coach.    He says he enjoys chess, but he doesn't seem to enjoy losing to Ed.    (Of course he can still beat Tim at any 
golf game they can create.)    Raffi is the only one in the group that has a old-fashioned ticker tape machine next to 
his desk to keep track of the stock markets.    When he hits it big we expect him to take us out for shish kabobs.



Grant

Grant is also one of the famed "Three Musketeers".    (He was the first, in fact.)    He's learning all there is to know 
about building Setup programs and other product packaging issues.    He also knows his way around bitmaps (he's 
another artistic one) and string tables.    He has literally worked his way up from the ground floor in order to get into 
software development.    He claims he started here as a young man, but after a few years he feels much older¾we 
think it's because he doesn't ever go home early (or perhaps not at all, we're not sure, since he's here when we arrive 
and he's here when we leave).



Joan

Joan (also known as Joanie) runs the Field Testing of all Executive Software products.    She sends and receives 
more e-mail in a day than many people do in a month, but manages to somehow keep it all straight and (almost 
always) sent to the right people.    She juggles hundreds of sites testing multiple products on multiple operating 
systems, yet makes it seem easy.    She's an avid bungee-jumper and skydiver, when she's not performing freestyle 
motocross jumping.    (OK, I made the last sentence up.)



Myron

Myron is one of the famed "Three Musketeers".    He’s the King of GUIs and engines and all sorts of other stuff.    
He also likes computer games, Tai Chi, and playing tennis.    He still hasn’t had a chance to play a round of tennis 
with Zack to determine the rightful owner of the prized Executive Software Cup.    (KooshÒ Tennis, anyone?)    
We're happy for his recent marriage, since he seems to smile a lot more, and yet he still puts in the same number of 
hours as before he was married.    Looks like she's a good influence.



Jane

Jane is now the official boss in the Development Division.    She's always been the "fixer" of the group, and has 
always pretty much run the show ¾ only now it's official.    She, too, has been around computers since they were 
really big water-cooled monsters (well, not that early, but she knows what the insides of a Cray look like).    She 
likes trivia, taking care of her dog (Angus, the largest dog you’ll ever meet) and cats (Koki and Hillary, two of the 
most interesting cats around), Science Fiction Sunday, her new house, photography (allegedly), and telling us that 
"Cyrmu" means "Wales".



Ernest

Ernest is the artistic one around here.    He rules the Bitmap Kingdom and runs the product packaging area.    This 
means he oversees the building of the installation procedures, and does a lot of other things that make it possible to 
get Diskeeper out the door and into your hands.    He still instigates the occasional KooshÒ basketball game (sorry, 
no more jump shots while hopping on one foot singing Danny Boy ¾ building management complained).    He's also 
the fisherman of the group, and we're waiting for him to put on the hip waders and go for a few trout in the fountain 
across the street.    You should see the "Trout of the Day" wallpaper he comes up with.



Zack

Zack, (also known as Z-Man), is always in a good mood (so much so that it bothers the rest of us).    He loves 
computers, physics, SCUBA, and weird science.    He's been instrumental in the development of the deeper parts of 
Diskeeper, and has had a lot to do with the long-term future of Diskeeper, all the while learning to love rainy 
weather.



John

John is known around here    as "Mr. Boot-Time", and he led the Diskeeper 4.0 software engineers.    He’s been 
working with computers since back in the days when hard drives were bolted to the floor on reinforced concrete 
foundations (what was known as the "Pizza Oven").    He’s forgotten more about computers and operating systems 
than most people will learn in their lifetime(s).    He enjoys all sorts of toys and gadgets (you should see his toybox). 
He also enjoys model rockets (he makes Saturn 5 rockets from scratch) and about anything to do with flying 
machines.    He is currently regrouping after the less-than-successful initial flight of the SR-71 Blackbird model 
rocket.



Mark

Mark supplies the gang with all the high-tech things we need to do our jobs.    We’re not really sure just what that is, 
but he keeps it all straight for us.    Without Mark, this place wouldn't run nearly as smoothly as it does.    He handles 
all the messy paperwork and administrative stuff so well we sometimes forget it exists.    He can also swap out a hard 
drive in the blink of an eye, and not even get this hands dirty doing it.    Top that off with being a very good writer 
and the owner of a really cool JeepÒ, and what else can you say?    Oh yeah ¾ many would say he’s the best-looking 
one of the group.    (But don’t tell Gary because he’ll get angry, and you don’t want to get Gary angry). 



Bert

Bert is the picky one of the group, but that's a good thing.    He’s responsible for making sure Diskeeper does what 
the developers say it will.    Bert decides when Diskeeper is ready to go into the public's hands, and can fight off a 
mob of hungry marketing people with a smirk and an icy stare.    (Must be all the hot sauce.)    He spends his spare 
time taking things apart and putting them back together.    Sometimes they even work when he’s done (even if 
there’s welding involved).    He’s into “tech” stuff ¾ automotive tech, mechanical tech, electrical tech, electronic 
tech, and sewing, of course.



Tim

Tim (the Lizard) likes beating Vaughn at pool, driving fast, and staying warm.    He also enjoys KooshÒ paddleball 
with Sopurkh.    He’s a tenacious bug hunter who can break any software he gets his hands on, and blue screen a 
computer faster than you can say "hemoglobin".    And please join us in rejoicing the arrival of his new brown 
leather jacket.    He's no longer the hollowed-out former shell of himself that he was when he lost the old one.



Vaughn

Vaughn is the writer of the gang and has written about Diskeeper since before Windows NT existed (although he 
turned over the bulk of the Diskeeper 4.0 writing to Peter).    He enjoys very little.    That’s just the way he is ¾ no 
sense of humor whatsoever.    Yeah, right.    He’s a retired rock-and-roll guitarist who got tired of the construction 
inspection business ¾ so of course now he’s into software development and writing Easter Eggs.    Go figure.    He 
likes to play pool (although Tim can usually teach him a thing or two) and is also involved in ground crew duties for 
several really cool hot-air balloons.



The Three Musketeers

"The Three Musketeers" is a collective name for Grant, Raffi, and Myron.    These three worked very closely 
together during the development of Diskeeper 3.0,and became quite the team.    During the development if Diskeeper 
4.0, they did somewhat different tasks, but they remain a tight team, and you seldom see one take a break without 
the others following.    Their multi-national backgrounds (Russian Armenian, Persian, and Chinese) has resulted in 
many very interesting conversations.



Gary

Gary (or Big G)    is the "Strongest Software Engineer in the World".    He lifts weights to get out from under the 
pressure of software development.    (Must have been a lot of pressure ¾ he can lift a small car.)    Few people 
around can tackle tough coding problems like Gary ¾ he's amazing. He’s a great person to take to lunch because he 
understands most foreign menus and he’ll clean up all your leftovers.    He’s also one of the nicest, most genuine 
people you could ever hope to know.    (I had to say that ¾ he’s bigger than me.)    Gary's been around Executive 
Software longer than any of the rest of us (although quite a few of us have been here longer than Windows NT has 
existed).



Andy

Andy, the head of our Research area, is the father of Diskeeper for Windows NT, 4 kids, and all of the other 
Executive Software Windows NT products.    He also racks up quite a few Frequent Flyer Miles going back and 
forth between here and Redmond.    Other than being an All-American Guy, he's a Hungarian-born, Canadian citizen, 
legal US Alien, adding to the international nature of the entire Diskeeper team.



Peter

Peter is the most recent addition to the Diskeeper development team.    He has taken over a large part of 
the technical writing duties with great patience and perseverance.    (He's become accustomed to working 
with a KooshÒ paddleball game going on over his head.)    Of course, in keeping with Executive 
Software's international flavor, he's from Holland.    He hasn't yet started his campaign to move our 
Technical Division to Frazier Park, but we think it's only a matter of time before he does¾and who can 
blame him?



Sopurkh

Sopurkh is a relative newcomer to the group.    He deals with development testing and localization for all our 
products.    He has been localizing for so long, he can sometimes be heard muttering to himself in German, French, 
or Japanese.    He's our token vegetarian, and he's the originator of Extreme KooshÒ Paddleball.    He's going to USC 
part-time ¾ this semester his hardest class was Sailing.    (We expect him to take Underwater Basket Weaving next 
semester if the the class is not already filled.)    Actually, he wants to finish some economics and language courses 
and fulfill his lifelong dream of being a Pirate.    Even though he only works here part-time, it sure seems like more.



Thank 
You!



cache

From the French word cacher, meaning “to hide.” A temporary storage facility designed to speed things up by 
providing information to software that would otherwise have to be obtained from a slower medium . Caches exist 
for Web browsers, disk drives and CPUs . See also cache memory . 



cache coherency

A condition where the data contained in the cache memories in a computer with multiple processors is kept 
consistent at all times.



cache memory

In computers, a cache is a small amount of very fast memory that is placed close to (or inside) the CPU chip , in 
order to improve performance. The cache memory holds copies of recently accessed data . Because computer 
programs often run the same instructions repeatedly, many times the CPU will find the data it needs in the cache 
and therefore will run faster because it does not need to access the computer’s main memory.



Service Pack

A collection of software used to issue corrections and updates to software between major releases.



European Technical Support

Registered users are entitled to 90 days of free telephone support, as well as special upgrade pricing, from 
Executive Software.    Our free European technical support is available Monday through Friday during the first 90 
days from 8:30 to 17:30 GMT.    If you have not yet registered your Diskeeper for Windows NT purchase, use the 
registration card in your Diskeeper box and do so now.    Or, register your purchase on-line via our Web site at:
http://www.execsoft.co.uk
Click here to visit Executive Software’s Web site:
{button Visit Executive Software,EF(`Connect.exe',"http://www.execsoft.co.uk",1)} 
Most technical support questions can be answered from the Technical Support    section of our Web site at the 
address shown above.
You may also contact our technical support team via the Internet at:
tech.support@execsoft.co.uk
or via FAX at:
+44 (0) 1342 327390
Executive Software also makes available unlimited technical support assistance via its support forum on 
CompuServe.    GO EXECSOFT to access this forum.
If you are within your 90 day free support period, or have purchased telephone support, you can call:
+44 (0) 1342 327477
When your 90 day free support period has expired, you may purchase the support plan which best suits your 
needs.    Executive Software offers 24-hour, 7-day support plans.    Contact Executive Software to find out which 
support options are best for you.
Executive Software's address is:
Executive Software
Kings House, Cantelupe Road
East Grinstead, West Sussex      RH19 3BE
England



Should I use Diskeeper on RAID arrays?

Definitely. Diskeeper supports all levels of software- and hardware-based RAID arrays.
RAID arrays are often used to increase system performance. In a RAID array of four disk drives, for example, a 
file can be accessed up to four times as fast as on a single drive. This is because the file is spread between the 
four drives, and all four drives can be accessed at the same time. Because of this, the file can be retrieved much 
more rapidly. However, these file parts can become fragmented on the individual drives, just like the files on a 
single disk drive, which reduces the speed advantage gained by RAID. In fact, the effects of fragmentation can be 
more obvious in a RAID array than in a single disk drive.
Diskeeper defragments RAID arrays just as it would single disk drives. Diskeeper sees the RAID environment 
just as the file system does. That is, Diskeeper defragments the virtual drive. Diskeeper improves the speed and 
performance of a RAID environment by eliminating wasteful and unnecessary I/Os from being issued by the file 
system. In our four-drive array example, it would defragment the pieces of the file on each separate drive as 
though they were separate files. Diskeeper moves pieces of a file as directed by the RAID controller.




